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ПРИМЕЧАНИЕ 
Экранные иллюстрации в этой публикации дают лишь примерное представление и не являются точными 
копиями экранных изображений, воспроизводимых программным обеспечением. 
 
Напечатанная инструкция пользователя 
Зарегистрированным владельцам ПО BERNINA Embroidery Software разрешается распечатать 1 (одну) 
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быть распечатана на собственном принтере или в копировальном магазине. 
 
Ограниченная Гарантия 
Фирма BERNINA International AG гарантирует, что в течение 90 дней с даты приобретения Вами 
программного обеспечения программные продукты не содержат дефектов по материалам и качеству 
исполнения. Вам предоставляется исключительное право в случае обнаружения таких дефектов 
возвратить изделия вместе с доказательством покупки фирме BERNINA или уполномоченным торговым 
агентам в течение гарантийного срока для безвозмездной замены. Вы оплачиваете стоимость пересылки 
и страховки  и несете риск в случае повреждения и ошибочной адресации "продуктов ". 
Покупатель полагается на свое собственное умение и знание при выборе программного обеспечения для 
собственного использования и принимает весь риск относительно результатов применения программного 
обеспечения. В соответствии с правовыми условиями гарантии фирма BERNINA International AG не 
принимает на себя все другие гарантии и условия, которые могут быть явно выражены или 
подразумеваемы, включая без ограничения, гарантии и условия пригодности для продажи, соответствия 
для специфического использования и отсутствие контрафакции. Фирма BERNINA International AG 
специально не гарантирует, что программное обеспечение будет соответствовать всем требованиям 
покупателя или будет выполняться без прерываний или ошибок, в полном соответствии с описанием в 
сопровождающей документации. 
 

Ограничения Ответственности 
Фирма BERNINA International AG, ее разработчики, менеджеры, служащие или работники филиалов в 
соответствии с применимым законом, ни в коем случае не несут ответственности за любые последующие 
прямые или косвенные убытки (включая убытки от потери деловой прибыли, перерывов в работе, потери 
коммерческой информации и т.п.), возникшие в результате неправильного использования программного 
обеспечения или прилагаемых защитного устройства и кабеля, а также сопровождающей документации, 
независимо от обоснования требования и даже, если фирма BERNINA или ее уполномоченный 
представитель уведомлялся относительно возможности таких убытков. 
В некоторых государствах законодательство или судебная практика не допускают исключения случайных, 
последующих или специальных убытков, так что вышеупомянутое ограничение или исключение не может 
быть применимо к Вам. 
 

Прекращение Действия Лицензионного Соглашения  
Ваша Лицензия на использование программного обеспечения фирмы BERNINA действительна до тех пор, 
пока Вы выполняете условия Лицензионного соглашения. Действие Лицензии завершится автоматически 
без уведомления фирмы BERNINA International AG, если Вы будете не в состоянии выполнять любое из 
условий Лицензионного соглашения. Вы можете прекратить действие этой Лицензии в любое время,  
возвратив программное обеспечение и все его копии этого, аппаратный ключ "донгл" (Dongle), кабель и 
всю сопровождающую документацию фирме BERNINA International AG. 
 

КОНТАКТНЫЕ ТЕЛЕФОНЫ 
Если у Вас возникнут любые вопросы, обращайтесь, пожалуйста, Вашему дистрибьютору фирмы 
BERNINA или  
BERNINA International AG  
CH-8266 Штекборн/Швейцария 
Тел.: (41) 52-762 11 11 
Факс: (41) 52-762 16 11 
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ГЛАВА 1 
 

ВВЕДЕНИЕ 
------------------------------------------- 

 
 
Приглашаем Вас ознакомиться с программным 
обеспечением BERNINA ARTlink – ведущим 
программным продуктом для домашнего 
машинного вышивания. BERNINA ARTlink 
является программным продуктом, основанным 
на операционной системе Windows, поэтому в 
нем используются многие команды, с которыми 
хорошо знакомо большинство пользователей 
персональных компьютеров. 
 
 

 
Первичным пользователям 
 
Если Вы впервые приобрели ПО 
BERNINA ARTlink,  то Вам очень 
понравятся гибкие возможности и 
легкость, с которой Вы сможете 
открывать и редактировать образцы 
вышивки. 
Вы должны также ознакомиться с 
главой Основные процедуры. Здесь Вы 
узнаете, как запускать приложение, 
открывать проект, распечатывать 
рисунки вышивок и как отправлять 
образец к вышивальной машине 
BERNINA.  Глава Просмотр проектов 
ознакомит Вас со способами просмотра 
проектов в режиме просмотра BERNINA 
ARTlink. 

Документация BERNINA ARTlink  

------------------- 
Документация BERNINA ARTlink 
включает в себя: 
◄ Руководство пользователя 
◄ Экранная справка 
 
Руководство пользователя 
 
Руководство пользователя имеется и в 
электронном виде. Оно  доступна из 
меню Help. 

 
Экранная справка 
Экранная справочная система доступна 
из меню Help программ BERNINA 
ARTlink. 
 

Условные, обозначения принятые в 
Руководстве 

------------------- 
В тексте руководства приняты 
следующие условные обозначения. 
 
Команды 
В этом руководстве команды меню или 
подменю указываются со ссылками на 
имена меню и команды. Например, 
команда ‘Show All’ (‘Показать Все’) из 
меню ‘View’ (‘Вид’) указывается как View 
> Show All. 
 
Диалоговые окна 
Диалоговые окна показываются в 
руководстве только в том случае, когда 
в них отображена важная информация 
для использования BERNINA ARTlink.  
Экранные иллюстрации дают лишь 
примерное представление и не 
являются точными копиями экранных 
изображений, воспроизводимых 
программным обеспечением. 
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Команды для действий мышью: 
 
Указание Символ Действие 
Щелчок 
мышью 

 

Щелкнуть левой 
кнопкой мыши 

Щелчок 
правой 
кнопкой 
мыши 

 

Щелкнуть правой 
кнопкой мыши 

Двойной 
щелчок  

Дважды щелкнуть 
кнопкой, не 
перемещая мышь 

Нажать 
кнопку ОК или 

 

Щелкнуть мышью на 
кнопке OK 
диалогового окна или 
нажать клавишу Enter 
клавиатуры, чтобы 
завершить действие. 

 

Комбинация 
клавиш 

Описание 

Ctrl + S  Удерживая нажатой клавишу 
CTRL, нажать клавишу буквы 
"S" в нижнем регистре 

Ctrl + SHIFT 
+ H  

Удерживая нажатой клавишу 
CTRL, нажать клавишу SHIFT 
и клавишу буквы "Н". 

 

Полный перечень клавиатурных команд 
приводится в Кратком руководстве 

Просмотр онлайновой информации 
------------------------------------------- 
• Выберите Help Topics (из меню Help), 

чтобы просмотреть онлайновую 
справку. 

• Выберите Online Manual (из меню Help), 
чтобы просмотреть онлайновое 
руководство. 

• Выберите Bernina International Home 
Page (из меню Help), чтобы 
просмотреть международный сайт 
Bernina. 

• Выберите Bernina of America Home 
Page (из меню Help), чтобы 
просмотреть сайт Bernina of America. 

• Выберите Embroidery Online (из меню 
Help), чтобы просмотреть сайт 
Embroidery Online. 

 

Документация пользователя 
предоставляется в виде  онлайнового 
руководства и онлайновой справки. 
 

Использование онлайновой справки 
Онлайновая справка обеспечивает быстрый 
доступ к общей информации о функциях 
BERNINA ARTlink и к пошаговым 
инструкциям. 
------------------------------------------- 

Как использовать онлайновую справку 
1  Выберите Help > Help Topics, чтобы открыть 

главное окно справки BERNINA ARTlink Help. 
2  Нажмите кнопку Contents (Содержание), 

чтобы открыть главный список тем справки. 
 Темы сгруппированы под заголовками 

высшего уровня со значками "книга". 
3  Дважды щелкните по значку "книга", чтобы 

просмотреть список тем, а затем дважды 
щелкните по выбранной теме. 

 Совет: Альтернативно нажмите кнопку Find 
(Найти) и введите ключевое слово, чтобы 
найти интересующий вас ответ.  

 

Просмотр онлайнового руководства 
Вы можете прочитать это онлайновое 
руководство, используя программу Adobe 
Acrobat™ Reader. Эта программа 
поставлена вам вместе с ПО BERNINA 
ARTlink. В онлайновом руководстве вы 
можете быстро найти нужную вам 
информацию, используя стандартные 
функции программы Adobe Acrobat™ 
Reader. 
------------------------------------------- 
Как просмотреть онлайновое 
руководство 
◄ Выберите Help > Online Manual. 

 
Примечание: Если программа BERNINA 
ARTlink не запущена, вы можете открыть 
экранное руководство непосредственно 
из Windows Explorer (Проводника 
Windows). Для этого найдите папку 
..\Program 
Files\BERNINA\ARTlink 6\bin и дважды 
щелкните по файлу 
UserManual.pdf. 
 
Соединение с сайтами BERNINA  
Вы можете получить доступ к информации о 
торговле и поддержке продуктов 
непосредственно из ПО. 
------------------------------------------- 
Как соединиться с сайтом BERNINA  
◄ Соединитесь с вашим интернет-

провайдером. 
◄ Выберите Help > BERNINA Web Page. 

Вы непосредственно соединитесь с 
домашней страницей BERNINA по 
следующим адресам:  

◄ Bernina International - 
http://www.bernina.com/ 

◄ Bernina of America - 
http://www.berninausa.com/ 

◄ Embroidery Online - 
http://www.embroideryonline.com 

 

Примечание: Вы должны иметь правильно 
сконфигурированный веб-браузер в свой 
системе совместно с доступом к Интернету.
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ГЛАВА 2 
 

ОСНОВНЫЕ ПРОЦЕДУРЫ 
------------------------------------------- 

 
 

Для работы с программным обеспечением BERNINA 
ARTlink вам требуется знать основные процедуры, 
такие как запуск программ, открытие и сохранение 
проектов. После запуска BERNINA ARTlink вы должны 
пользоваться командами или пиктограммами и 
диалоговыми окнами, чтобы выполнять 
соответствующие задачи. Команды выбираются таким 
же образом, как и в других приложениях Windows, – из 
меню или панелей инструментов. 
В приложениях BERNINA ARTlink открываются файлы 
в "родном" формате .ART, а также файлы других 
вышивальных форматов, хранящиеся на жестком диске компьютера, дискете или 
компакт-диске. 
 
Программный пакет BERNINA ARTlink предлагает вам на выбор широкий диапазон 
стандартных пялец. Используйте линии сетки, чтобы точно совместить или 
установить требуемые размеры объекта вышивки.  
 
В этом разделе описывается, как запустить приложения BERNINA ARTlink и 
соответствующие команды и инструменты. Они требуются для открытия и 
сохранения файлов с проектами. Объясняется, как активировать пяльцы и линии 
сетки. 

 
 

Запуск вышивального 
программного обеспечения 
BERNINA ARTlink  
------------------------------------- 

 
Для запуска BERNINA ARTlink 
щелкните дважды мышью по этому 
ярлыку. 
 
 
 

Программа BERNINA ARTlink может быть 
открыта через ярлык на рабочем столе 
или меню кнопки Пуск.  
 

 
Как запустить BERNINA ARTlink  
------------------------------------- 
 
◄ Щелкните дважды мышью по ярлыку 

BERNINA ARTlink на рабочем столе 
Windows. 

 
Альтернативно выберите в меню кнопки 
Пуск > Все программы > BERNINA 
ARTlink > BERNINA Embroidery Software. 
 
BERNINA ARTlink открывается с новым, 
пустым проектом (Design1). На 
показанном внизу экране отображены в 
развернутом виде все панели 
инструментов приложения BERNINA 
ARTlink. 
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Строка 
заголовка  

 
Панель 

изображения 
 

Строка меню 
 

Общая панель 
инструментов 

Панель 
инструментов 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Строка 
состояния 

 
Примечание: Панели являются 
плавающими, их можно размещать 
справа, слева, сверху или снизу и 
"перетаскивать" в любое место экрана.  
 

◄ Измените окно проекта по своему 
желанию, при этом можно отобразить 
или скрыть сетку, изменить размеры 
сетки, отобразить или скрыть панели 
инструментов. Подробнее см. в 
разделе Отображение сетки. 

 
Совет: В строке состояния дается ценная 
информация по текущему проекту.   
 
◄ Индикаторы W и H показывают ширину  
и высоту проекта. 

 
 

◄ За ними следуют измерительные 
индикаторы X, Y, L и A. Подробнее см. в 
разделе Измерение расстояний на 
экране. 

 
◄ Следом за измерительными 

индикаторами находятся индикаторы 
Total Stitch Count (Общее количество 
стежков) и Zoom Factor ( Коэффициент 
масштаба). См. также раздел 
Увеличение и уменьшение изображения.  

 

◄ С правого края находится индикатор File 
Type (Тип файла). "Родные" для 
BERNINA ARTlink проекты формата ART 
классифицированы на четыре группы в 
зависимости от способа создания 
файла. Подробнее см. в разделе 
Форматы проектов вышивки экранного 
руководства. 

 
Использование команд и 
инструментов 
------------------------------------ 
После запуска BERNINA ARTlink вы должны 
пользоваться командами или ярлыками и 
диалоговыми окнами, чтобы выполнять 
соответствующие задачи. Команды 
выбираются таким же образом, как и в 
других приложениях Windows®, – из меню 
или панелей инструментов. Для наиболее 
часто используемых команд имеются также 
клавишные комбинации быстрого вызова – 
клавиатурные команды. Подробнее см. в 
разделе Клавиатурные команды. 
 
Выбор команд с панелей 
инструментов 
 

Панели инструментов обеспечивают 
быстрый и простой доступ к командам 
BERNINA. Щелкните на кнопке инструмента, 
чтобы активировать команду, или, там, где 
это применимо, щелкните правой кнопкой 
мыши, чтобы изменить ее свойства. 
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Как выбирать команды с панелей 
инструментов 
------------------------------------ 
 

◄ Задержите указатель мыши на значке 
инструмента, чтобы увидеть его 
название во всплывающей подсказке.  

 
◄ Щелкните по значку, чтобы активировать 

команду. 
◄ Правой кнопкой, чтобы отрегулировать 

настройки или активировать вторичную 
команду. 
◄ Если для значка предусмотрены 

команды как от левой, так и от правой 
кнопки мыши, то ее название 
разделено косой чертой (/). 
Например, значок Scale by 20% 
Down/Up позволяет уменьшить 
размер объекта на 20 %, если 
щелкнуть левой кнопкой мыши, или 
увеличить размер на 20 %, если 
щелкнуть правой кнопкой. 

◄ Для многих инструментов щелчок 
правой кнопкой мыши дает 
возможность настроить текущую 
команду. Например, щелчок левой 
кнопкой по Show Hoops показывает 
пяльцы или скрывает их, а щелчок 
правой дает доступ к диалоговому 
окну Options – Hoops. Подробнее см. 
в разделе Пяльцы и сетки. 
 

 
Отмена и повторение отмененных 
команд 
 

Используйте кнопку Undo (панель 
General) для отмены команды. 
 
Используйте кнопку Redo (панель 
General) для повторения команды, 
которая была отменена. 

 

Вы можете отменить действие большинства 
команд. Если вы передумали, то можно 
снова повторить выполнение отмененной 
команды. BERNINA ARTlink помнит 
несколько последних команд, которые вы 
назначали. 
------------------------------------ 
Как отменить команду и снова 
восстановить ее действие 
◄ Для отмены команды щелкните по 

значку Undo. Если BERNINA ARTlink 
больше не помнит выполненных 
команд, кнопка Undo становится 
блеклой.  

◄ Щелкните по значку Redo, чтобы 
повторить выполнение отмеченной 
команды. 

 
Перемещение и установка 
панелей инструментов 
 
Панели инструментов обеспечивают 
быстрый и простой доступ к командам 
BERNINA ARTlink. Панели инструментов 
являются "плавающими". Это означает, 
что их можно перемещать по всему окну 
проекта. 
  
Как перемещать панель 
инструментов 
 
◄ Для перемещения панели 

инструментов в более удобное место 
нужно перетащить ее мышью: 
◄ Панели инструментов можно 

перемещать влево, вправо, вверх и 
вниз. 

◄ Они могут "плавать" в любом месте 
окна. 

 
 

◄ Для помещения панели в 
нормальное положение дважды 
щелкните мышью по заголовку. 
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Работа с файлами проектов 
------------------------------------ 
По умолчанию BERNINA ARTlink сохраняет 
проекты в собственном ["родном"] формате 
файла .ART. Этот формат содержит всю 
информацию, требуемую как для 
вышивания проекта, так и для последующих 
изменений. В приложениях BERNINA 
ARTlink открываются файлы в "родном" 
формате .ART, а также файлы других 
вышивальных форматов, хранящиеся на 
жестком диске компьютера, дискете или 
компакт-диске. Вы можете сохранять 
проекты в разных форматах ART. 
 
ART-файлы  
 
Проекты в "родном" ART-формате, называемом 
‘ART Grade A’, содержат полный комплект 
информации о проекте в едином файле – 
контуры объекта и его свойства, фактические 
стежки, цвета ниток, пиктограмма и 
комментарии. Формат Grade В более надежен, 
чем Grade С, но не так хорош, как формат Grade 
А, а Grade D является наименее надежным 
форматом. 
Само собой разумеется, что только файлы 
формата ART Grade A обеспечивает полные 
возможности изменения размеров и 
преобразования.  
 
 
Источник 
файла 

Описание 

Art  
Grade A  

 

Файл чистого формата ART, 
созданный программным 
обеспечением BERNINA ARTlink. 
Такие файлы содержат "чистые" 
ART объекты, контуры и стежки. 

Art  
Grade B  

 

Проекты, считанные с контурного 
формата и сохраненные как ART-
файлы. Такие проекты не могут 
быть считаны непосредственно в 
программе BERNINA ARTlink, но 
будучи конвертированы в формат 
ART в другой программе, они 
открываются в BERNINA ARTlink как 
файлы формата Grade B.. 

Art  
Grade C 

Проекты, считанные со стежковых 
файлов SEW, PCS, PES и др. – в 
которых стежки конвертированы в 
объекты 

Art  
Grade D 

Проекты, считанные со стежковых 
файлов SEW, PCS, PES и др. –  в 
которых стежки НЕ конвертированы 
в объекты. 
 

 
Для информации об источниках файла проекта 
обратитесь к Информации о проекте (Design 
information) в диалоговом окне Open (Открыть) 
или Design Properties (Свойства проекта). 
Подробнее см. в разделе Просмотр информации 
о проекте в BERNINA ARTlink. 

 
Открытие проектов 

 
Нажмите кнопку Open (панель General), 
чтобы открыть существующий проект. 
 

BERNINA ARTlink открывает ряд 
вышивальных файлов не только в "родном" 
формате ART. "Родные" проекты формата 
ART классифицированы на четыре группы в 
зависимости от способа создания файла. 
См. также Запуск вышивального 
программного обеспечения BERNINA 
ARTlink. 
 
Внимание: Вы не сможете открыть файлы 
ART, созданные более поздней версией 
программного обеспечения, если у вас 
запущена предыдущая версия. Если вы 
попытаетесь это сделать, появится 
указание о необходимости обновить 
систему до текущей версии. 
------------------------------------ 
Как открыть проект 
 
1 Нажмите кнопку Open (Открыть). 
Откроется диалоговое окно Open. 
 

 
Чистый 

формат ART 
 
2 Выберите папку из списка Look In. 
 

Примечание: Вы можете считывать 
проекты, сохраняемые на дискете, 
компакт-диске или на жестком диске 
компьютера. 

 

3 Если проект не в формате ART, то 
выберите тип файла из списка Files of 
Type (Тип файлов). 

4 Выберите проект или проекты.  
◄ Для выбора нескольких идущих 

подряд проектов удерживайте 
нажатой клавишу Shift.  

◄ Для выбора нескольких файлов 
удерживайте нажатой клавишу Ctrl. 
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5  Проставьте "галочку" в окошке Preview, 
чтобы просмотреть проект (для 
поддерживаемых форматов) вместе с 
данными о проекте. В эти данные входят 
количество стежков (S:) и цветов (C:), 
высота (H:) и ширина (W:) проекта и 
номер версии ПО (V:). 

6 Нажмите кнопку Open (Открыть). 
 

Примечание: Вы можете также 
считывать проекты из памяти вашей 
вышивальной машине. Подробнее см. 
в разделе Считывание и запись 
файлов проектов экранного 
руководства. 

 
Сохранение проектов 

 
Нажмите кнопку Save (панель General), 
чтобы сохранить текущий проект. 

 
Не все проекты BERNINA ARTlink могут 
быть сохранены в чистом ART-формате. 
Программа BERNINA ARTlink сохраняет 
проект в таком же виде «Grade“, в котором 
он открылся. При сохранении проекта 
сохраняется имя файла, его расположение 
и формат и происходит его обновление в 
соответствии с выполненными 
изменениями.  Если вы сохраняете 
существующий проект под новым именем, в 
другом месте или в другом формате, вы 
создаете копию оригинального проекта. См. 
также раздел Считывание и запись файлов 
проектов экранного руководства. 
 
Совет: Сохраняйте свои проекты во время 
работы, как можно чаще. Не ждите полного 
завершения работы. Чтобы сохранить 
изменения в существующем файле, но 
оставить без изменений оригинал, 
воспользуйтесь командой Save As. Каждый 
раз, когда вы сохраняете проект кнопкой 
Save на общей панели инструментов, 
происходит обновление файла.  
------------------------------------ 
 
Как сохранить проект 
 
1    Нажмите кнопку Save (Сохранить). 

Если вы сохраняете проект в первый 
раз, откроется диалоговое окно Save As 
(Сохранить как …). 

 
Папка, содержащая 
проект 

 
 
 

 
 
 
 
 

Список 
форматов 

 
2 Из списка Save In выберите папку, в 

которой вы хотите сохранить проект. 
3 Введите имя проекта в поле File name. 
4 Выберите формат файла из списка Save 

as type.   
5  Нажмите кнопку Save (Сохранить). 
 

Примечание: Вы можете также 
записывать проекты в память вашей 
вышивальной машине.  Подробнее см. в 
разделе Считывание и запись файлов 
проектов экранного руководства. 

 
Пяльцы и сетки 
------------------------------------ 
 
Перед вышиванием на машине материал 
должен быть растянут в пяльцах. 
Программный пакет BERNINA ARTlink 
предлагает вам на выбор широкий 
диапазон стандартных пялец. Используйте 
линии сетки, чтобы точно совместить или 
установить требуемые размеры объекта 
вышивки. 
 
Отображение пялец 
 

Для отображения пялец 
нажмите кнопку Show Hoop 
(панель General). Щелчок  

      правой кнопкой мыши  
      позволяет изменить настройки. 

Каждый раз, когда вы запускаете BERNINA 
ARTlink, по умолчанию в окне проекта 
появляются большие пяльцы. Эти пяльцы 
представляют собой одни из тех пялец, 
которые устанавливаются на машине. Когда 
вы позиционируете объекты, положение 
пялец подгоняется автоматически, так что 
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объекты всегда находятся в центре пялец. 
См. также раздел Закрепление проектов в 
пяльцах экранного руководства. 
------------------------------------ 
 

Как показать пяльцы на экране 
 
◄ Нажмите кнопку Show Hoop (Показать 

пяльцы), чтобы отобразить пяльцы. 
 

 
 

◄ Нажмите еще раз кнопку Show Hoop, 
чтобы скрыть пяльцы. 

 
Отображение сетки 
 

Нажимайте кнопку Show Grid (панель General) 
для отображения на экране или 
скрытия сетки. Щелчок правой  
кнопкой мыши позволяет изменить  
                настройки сетки. 

 

Используйте линии сетки, чтобы точно 
совместить или установить требуемые 
размеры объекта вышивки. Вы можете 
показывать или скрывать сетку. 
 

Совет: Вы можете изменить интервал 
сетки, выбрать базисную точку и 
включить или выключить функцию Snap to 
Grid (Выровнять по сетке) в диалоговом 
окне Options. Подробнее см. в разделе 
Настройка опций сетки экранного 
руководства. 
------------------------------------ 
 

Как показать сетку на экране 
◄ Нажмите кнопку Show Grid (Показать 

сетку), чтобы отобразить сетку.  
  
  

◄ Нажмите кнопку Show Grid еще раз, 
чтобы скрыть сетку. 

Измерение расстояний на экране 
 
Используйте команду Measure (меню View), 
чтобы измерить расстояние на экране. 
 

Для измерения расстояния между двумя точками 
на экране используйте команду Measure 
(Измерить). Эта команда отображает 
координаты, расстояние и угол линии от 
указателя мыши до точки, соответствующей 
центру пялец в пустом проекте. Результаты 
измерения можно видеть в строке состояния или 
в подсказке. Подробнее см. в разделе 
Интерпретация положения указателя мыши 
экранного руководства. 
 
Совет: Для получения более точных 
результатов перед измерением увеличьте 
изображение на экране. Измеряется всегда 
действительный размер независимо от 
масштаба изображения. 
 
Как измерить расстояние на 
экране 
 

1   Выберите View > Measure или нажмите M. 
2   Щелкните мышью по начальной точке. 
3   Удерживая кнопку мыши нажатой, 
переместите указатель мыши в конечную точку. 

В строке состояния появится следующая 
информация: 
◄ Координаты положения конечной точки 

(X=, Y=). 
◄ Длина измеренной линии (L=). 
◄ Угол наклона линии по отношении к 

горизонтали (A=). 

 
Результаты изменения появляются как подсказка 
или в строке состояния 

 
Результаты измерений показываются в 
миллиметрах или дюймах, в зависимости ль 
выбранной системы измерения в Панели 
управления MS Windows®. Подробнее см. в 
документации по операционной системе MS 
Windows®. 

 
Совет: Если активировано измерение длины 
и угла, результаты появляются также и в 
подсказке. Подробнее см. в разделе Скрытие 
всплывающей подсказки инструмента 
Measure экранного руководства.  
 
4 Нажмите Esc один раз, чтобы обновить 

первую точку измерения. 
5 Нажмите Esc в два раза для 

завершения. 
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ГЛАВА 3 
 

ПРОСМОТР ПРОЕКТОВ 
------------------------------------------- 

BERNINA ARTlink предоставляет несколько возможностей просматривать проекты 
вышивки, чтобы облегчить работу с ними. Zoom in on an area to see more detail or view 
the design at actual size. Можно рассматривать существующий проект с различными 
цветами на разных материалах. Вы может показывать или скрывать точки прокола 
иглой. 

 
Даже перед открытием BERNINA ARTlink или своего проекта вы можете проверить 
версию ПО и некоторую информацию о файлах формата ART непосредственно из 
Проводника Windows. Вы можете просмотреть детали вышивания проекта в 
диалоговом окне Design Properties (Свойства проекта). Важную информацию о 
проекте дает также функция Print Preview (Предварительный просмотр), включая 
просмотр проекта в целом, размеры проекта, последовательность цветов и 
специальные указания. 
 
В этом разделе разъясняются режимы просмотра проекта, предоставляемые 
BERNINA ARTlink, а также различные настройки просмотра проекта. Также 
объясняется, как получать и модифицировать информацию о ваших проектах. 

 

Режимы просмотра проектов 
BERNINA ARTlink предлагает несколько 
различных режимов просмотра. Вы 
можете увеличить изображение на всю 
площадь экрана, чтобы увидеть больше 
деталей, просмотреть проект в 
натуральную величину, а также подогнать 
изображение проекта к размерам экрана. 
Режим Artistic View позволяет вам 
увидеть проект в том виде, в котором он 
будет выглядеть после вышивания. 
 
Режимы просмотра 
 

Нажмите на кнопку Show Artistic View 
(панель General), чтобы включить или 
выключить режим просмотра «Design»  

             или „Artistic“. 

 
 
BERNINA ARTlink предоставляет два 
режима просмотра проекта – «Design» 
(Просмотр проекта) и «Artistic» 
(Художественный просмотр) 
Используйте режим просмотра проектов  
для открытия проектов, просмотра 
стежков и последовательности стежков. 
 
Режим Artistic View позволяет получить 
графическое представление о том, как 
должна выглядеть вышивка в 
окончательном виде. В этом режиме 
проект выглядит более реалистично, чем  
в режиме Design View. В режиме Artistic 
View доступны все команды 
редактирования. 
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Как просматривать проекты в 
режиме Artistic View 
 

• Нажмите на кнопку Show Artistic View, 
чтобы переключаться между режимами 
«Design» и „Artistic“. 

 
Альтернатив: Нажмите клавишу T, чтобы 
переключаться между режимами. 
 

Совет: Используйте режим Artistic View 
совместно фоном материала, чтобы 
увидеть, как будет выглядеть вышивка на 
выбранном материале. Подробнее см. 
«Изменение фона».        
 
Увеличение и уменьшение  
изображения 

    Щелкните по Zoom Box (панель General) 
для увеличения и уменьшения 
изображения в окне проекта. 
Используйте этот инструмент также в 
оконтуренных областях экрана. 
 
 
Щелкните по Show All (панель General), 
чтобы показать весь проект. 
 
 
Щелкните по Show 1:1 (панель General), 
чтобы показать проект в натуральную 
величину. 

 
Увеличьте изображение проекта вышивки, 
чтобы рассматривать индивидуальные 
стежки или детали, или уменьшите его, 
чтобы отобразить в окне большее 
количество деталей проекта. Текущий 
масштабный коэффициент показывается в 
нижнем правом углу экрана. См. также 
Клавиатурные команды. 
 
Примечание: Чтобы быть уверенным в том, 
что проект отображается на экране в 
правильных размерах, необходимо 
калибровать монитор. Подробнее см. в 
разделе Калибровка монитора экранного 
руководства. 
 
Как увеличить и уменьшить изображение 
на экране 
 

◄ Щелкните по значку Zoom Box или 
нажмите клавишу B.Указатель мыши 
примет вид лупы. 

◄ Щелкните правой кнопкой в окне проекта 
– изображение уменьшится наполовину 
от предыдущего размера, его центр 
будет находиться в точке щелчка.  
 

Щелчок правой кнопкой мыши 
Совет: В строке состояния показывается 
текущий "коэффициент 
масштабирования". Подробнее см. 
Запуск вышивального программного 
обеспечения BERNINA ARTlink. 
 

◄ Щелкните левой кнопкой в окне проекта 
– изображение увеличится вдовое по 
сравнению с предыдущим размером, его 
центр будет находиться в точке щелчка.      
 

◄ Щелкните левой или правой кнопкой и 
перетащите ограничивающий 
прямоугольник вокруг 
масштабированной зоны. Отпустите 
кнопку мыши, чтобы увидеть всю 
масштабированную зону на экране. 

 
◄ Чтобы отобразить весь проект, нажмите 

кнопку Show All. Альтернативно 
выберите View > Show All, или нажмите 
0.  

◄ Чтобы отобразить проект в натуральную 
величину, нажмите кнопку Zoom 1:1.  

◄ Для отображения стежков в частичном 
масштабе нажмите клавишу F на 
клавиатуре. Введите величину 
масштабирования в процентах и 
щелкните по OK. 

 
Введите масштаб 

◄ Нажмите клавишу Esc, Enter или 
Клавишу пробела, чтобы выйти из 



Глава 3: Просмотр проектов 

 

BERNINA® Вышивальное ПО ARTlink 6  11

режима Zoom. 
Просмотр точек укола иглой 
 
Выберите Needle Points в меню View, чтобы 
показать или скрыть точки укола иглой. 
 
Вы можете показать или скрыть элементы 
проекта, такие как точки укола иглой или 
соединительные стежки. Например, 
просмотреть точки укола иглой для выбора 
стежков для редактирования стежков, чтобы 
облегчить позицию ввода стежков и точек 
выхода. . 
 
Как просмотреть точки укола иглой 
◄ Для просмотра или скрытия точек укола 

иглой выберите View (Вид) > Needle 
Points (Точки укола иглой). 

 

 
                          
 
              
 
 
 
 
 
 
 

Функция Needle       Деталь с показом  
Points включена      точек укола иглой 
 

Просмотр последовательности 
вышивания отдельных 
фрагментов 
При работе с проектами вышивки вам 
необходимо разобраться с 
последовательностью вышивания. Вы 
можете проверить последовательность 
вышивания проекта путем ‘обхода’ по 
стежкам, цветам или объектам. Вы можете 
также проверить последовательность 
медленным перерисовыванием проекта на 
экране. BERNINA Editor Lite имитирует 
вышиванием при изменении стежков от 
черного до назначенного цвета нитки, как 
это происходит при вышивании. 
 
Обход проекта от начальной до 
конечной точки 
 
Нажмите клавишу Home, чтобы перейти к 
начальной точке проекта. 
Нажмите клавишу End, чтобы перейти к 
конечной точке проекта. 
 
Используйте клавиатурные команды, чтобы 
быстро переходить к начальной или 

конечной точке последовательности 
вышивания.  
 
Как переходить от начальной до 
конечной точки проекта  
 
◄ Для перехода к начальной точке 

проекта нажмите клавишу Home. 
Весь проект отображается темно-серым 
цветом. 
 

◄ Для перехода к конечной точке проекта 
нажмите клавишу End.  
Весь проект отображается с 
выбранными цветами ниток. 

 
Обход по объектам 
Используйте клавиатурные команды для 
обхода проекта по объектам.  
 
Как обойти проект по объектам 
 
◄ Для перехода к начальной точке 

проекта нажмите клавишу Home.  
Чтобы перейти к следующему объекту, 
нажмите Ctrl + T. 

 
 

◄ Чтобы перейти к предыдущему объекту, 
нажмите Shift + T. 

 
 
Обход проекта по цвету 
Используйте клавиатурные команды для 
обхода проекта по цвету.  
 
Как обойти проект по цвету 
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◄ Чтобы перейти к предыдущему цвету, 
нажмите клавишу Page Up. 
 

Первый цвет                   Второй цвет  
      – желтый                    - оранжевый 
 
◄ Чтобы перейти к следующему цвету, 

нажмите клавишу Page Down.  
 
Обход по стежкам 
Используйте соответствующие инструменты 
или клавиатурные команды для обхода 
проекта по одному или по нескольким 
стежкам. Текущее положение иглы 
отмечается большим белым  
крестом, или "маркером положения иглы". 
Вначале он располагается в конечной точке 
проекта. Когда вы совершаете обход по 
стежкам, маркер положения иглы 
соответственно перемещается. Текущий 
номер стежка появляется в Строке 
состояния. 
 
 
 
 
 
 
 
 
 
 
Как обойти проект по стежкам 
 

1  Убедитесь в том, что функция Select 
Object (Выбрать объект) не выбрана 
(нажмите клавишу Esc), затем 
нажимайте клавиши со стрелками, чтобы 
обходить проект по одному или по 
десять стежков. 
 

◄ Нажимайте левую или правую 
клавишу со стрелкой, чтобы обойти 

проект по одному стежку в обратном 
или прямом направлении. 

◄ Нажимайте верхнюю или нижнюю 
клавишу со стрелкой, чтобы обойти 
проект по десять стежков в обратном 
или прямом направлении. 

◄ Нажимайте клавишу "+" или "-" на 
клавиатуре, чтобы обойти проект 
шагами по 100 стежков. Клавишей 
"+" маркер перемещается в прямом 
направлении, клавишей "-" в 
обратном направлении. 

 

 
Обход в обратном направлении по 1 стежку 
 
Совет: Если вы вышли за пределы видимой 
области, нажмите клавишу C, чтобы 
текущий стежок оказался в центре экрана. 
 
Замедленный просмотр 
последовательности вышивания 
отдельных фрагментов 
 
1 Выберите View > Slow Redraw или 
нажмите Shift+R. 
Откроется диалоговое окно Slow Redraw. 

 
2 Используйте ползунок для установки 
скорости перерисовывания. 
3 Нажмите кнопку Play. 
Проект будет перерисован на экране в 
соответствии с последовательностью 
вышивания. 

 
4 Нажмите кнопку STOP для остановки. 
Остаток проекта перерисован.  
прекращения перерисовку.  

белый крест – 
маркер положения  

иглы 
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Обзор клавиатурных команд для 
просмотра последовательности 
вышивания 
 

следует нажать на 
основной клавиатуре 

Чтобы перейти ... 

 
к началу проекта  Home 
к концу проекта  End 
на 1 стежок вперед  → 
на 1 стежок назад  ← 
на 10 стежков вперед  ↓ 
на 10 стежков назад  ↑ 
на 100 стежков вперед  + 

(на цифровой панели) 
на 100 стежков назад  - 

(на цифровой панели) 
к предыдущему цвету  Page Up 
к следующему цвету  Page Down 
к следующему объекту  Ctrl+T 
к следующему объекту  Shift + T 
 
Выбор объектов  
 

Щелкните по Select Object (панель Edit), 
если необходимо (эта кнопка 
активирована по умолчанию) и 

щелкните по объектам для выделения. 
 
Как выбрать объекты в проекте 
 
1  Нажмите кнопку Select Object (Выбрать 

объект). 
2  Щелкните по объекту, который вы хотите 

выбрать. 
 Когда вы щелкните по объекту, вокруг 

него появятся метка-манипулятор 
выделения. Вы можете щелкнуть где-
либо в пределах выделения, чтобы 
перетащить объект. 

 

 
 
Не выделен объект                    Выделен объект 
 
◄ Отменяйте выделения нажатием на  

Esc. 

 
Как отменить выделение 
объектов 
◄ Отменяйте выделения одним из 

следующих способов: 
◄ Нажмите Esc. 
◄ Щелкните мышью на пустом месте 

фона. 
 
Изменение фона 
Для изменения цвета фона функцию Thread 
Colors (меню Settings). 
BERNINA ARTlink дает возможность 
выбирать цвет фона в окне проекта, чтобы 
согласовать его с цветом вашей ткани. Или 
же можно выбрать фон ткани для более 
реалистичного вида и воспроизведения. 
Фон сохраняется вместе с проектом. 

 
     Оранжевый фон             Синий фон 
Как изменить цвет фона 
 
1 Выберите Settings (Настройки) > 
Thread colors (Цветa ниток)..  
Откроется диалоговое окно Design 
properties  - Thread colors 
                  
Дважды щелкните, чтобы изменить  цвет фона 

. 
2     Выберите BKG из списка.  



Глава 3: Просмотр проектов 

 

BERNINA® Вышивальное ПО ARTlink 6  14

 

3     Щелкните по Edit.  
 Откроется диалоговое окно Display. 

 
4     Щелкните по Edit.  
5     Для выбора цвета фона, выберите 
        цвет из диалогового окна Color  
       (Цвет).  

 
 
 
 
 
 
 
 
 
 
 

 
6      Нажмите кнопку ОК.  
        Фон сохраняется вместе с проектом. 
 
Просмотр информации о проекте 
 
BERNINA ARTlink предоставляет 
информацию о проектах разнообразными 
способами и в разных форматах. Еще 
перед открытием BERNINA ARTlink или 
своего проекта вы можете проверить номер 
версии ПО  и некоторую информацию о 
файлах формата ART непосредственно из 
MS Windows® Explorer. Вы можете 
просмотреть детали вышивания в 
диалоговом окне Design Properties 
(Свойства проекта). Важную информацию 
о проекте дает функция Print Preview 
(Предварительный просмотр), включая 
просмотр проекта в целом, размеры 
проекта, последовательность цветов и 
специальные указания. 
 
Просмотр свойств проекта 
 
Используйте функцию Design Properties (меню 
File), чтобы увидеть детали вышивания проекта. 
 
В диалоговом окне Design Properties 
(Свойства проекта) вы можете проверить 
номер версии программного обеспечения и 
другую информацию. Приводятся также 
детали вышивания. Большинство данных в 

этих полях не подлежат непосредственному 
изменению. 
 
Как просмотреть свойства 
проекта  
 
1   Выберите File > Design Properties. 

Откроется вкладка Design диалогового 
окна Design Properties . 

 
2 Выберите закладку Summary, чтобы 

увидеть или ввести информацию о 
проекте. 

 
3 Щелкните на поле и введите любой 

текст, который поможет вам 
впоследствии идентифицировать 
проект. 

 
Примечание: Информация из этой 
вкладки включена в окно 
Предварительного просмотра, а также во 
вкладку Summary диалогового окна 
Windows Properties. Подробнее см. в 
разделах Просмотр информации о 
проекте в Проводнике Windows  и 
Предварительный просмотр проектов.  

4   Нажмите кнопку OK. 
 
Предварительный просмотр 
проектов 
 
Нажмите кнопку Print Preview (панель General), 
чтобы увидеть на экране проект в том виде, в 
котором он может быть распечатан. 

Выберите новый цвет 



Глава 3: Просмотр проектов 

 

BERNINA® Вышивальное ПО ARTlink 6  15

 
Функция Print Preview (Предварительный 
просмотр) позволяет получить важную 
информацию о проекте, включая просмотр 
проекта в целом, размеры проекта, 
последовательность цветов и специальные 
указания. См. также раздел Распечатка 
проектов экранного руководства. 
------------------------------------ 
 
Как предварительно просмотреть 
проект 
 
1  Нажмите кнопку Print Preview 
(Предварительный   просмотр). В окне 
предварительного просмотра появится 
изображение проекта. 
     Щелкните, чтобы распечатать проект   
     Нажмите, чтобы показать одну или две 
страницы. Щелкните, чтобы настроить опции 
печати 

 
2  Настройте требуемый вид изображения: 

◄ Для изменения ориентации на бумаге 
выберите Landscape (Альбомная) 
или Portrait (Портрет).  

◄ Для изменения отображаемой 
информации и установки требуемых 
опций печати выберите Options. См. 
также Настройка опций печати 
вышивальных файлов в экранном 
руководстве.  

◄ Нажмите Zoom In, чтобы прочитать 
информацию о проекте или более 
подробно просмотреть проект. 
Большие проекты могут быть 
отображены на нескольких страницах. 

◄ Чтобы распечатать проект, нажмите 
Print.  
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ГЛАВА 4 
 

ЗАКРЕПЛЕНИЕ ПРОЕКТОВ В 
ПЯЛЬЦАХ 

------------------------------------------- 
 
 

Перед вышиванием на машине материал должен быть растянут в пяльцах. 
Программный пакет BERNINA ARTlink предлагает вам на выбор широкий диапазон 
стандартных пялец. Если у вас есть пяльцы, которых нет в списке, вы можете 
определить собственные пяльцы по своему эскизу или на основе стандартных пялец. 
См. также Отображение пялец. 

 

 
 

 
В этом разделе описывается, как выбирать и отображать пяльцы в программах 
BERNINA ARTlink. Объясняется, как создавать и модифицировать пользовательские 
пяльцы. Также даются указания, как закреплять в пяльцах крупные проекты. 
 

Выбор пялец 
 
Каждый раз, когда вы создаете новый 
проект, по умолчанию в середине окна 
проекта появляются пяльцы, которые вы 
установили на вышивальной машине. Когда 
вы позиционируете объекты, положение 
пялец подгоняется автоматически, так что 
объекты всегда находятся в центре пялец. 
Инструмент Show Hoop позволяет 
отображать или скрывать пяльцы. Диапазон 
размеров пялец дает возможность широкого 
выбора типов проекта.  

 
Изменение пялец 
 

Щелкайте по кнопке Show Hoop (панель 
General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой 
мыши позволяет изменить настройки  

       пялец. 
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Из предоставляемого вам списка пялец с 
разными размерами выберите наименьшие 
пяльцы, которые подходят к вашему 
проекту.  Благодаря этому ткань в время 
вышивания будет оставаться плотно 
натянутой. См. также  
 

Примечание: Когда вы выбираете новые 
пяльцы, они становятся "текущими" до тех 
пор, пока не будут изменены в текущей или 
последующей сессии. 
 
Как изменять пяльцы 
1.  Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop. 
 Появится диалоговое окно Options> 

Hoop.  

Выберите требуемый размер пялец 
2.  Выберите пяльцы из списка Hoop. 
3.  Если требуется поместить важную часть 

проекта в определенной части пялец, 
выберите опцию Manual и опцию Set 
Hoop Center (Установить центр пялец). 

4.  Щелкните по OK. 
 Если вы выбрали опцию Set Hoop 

Center, щелкните в окне проекта, в том 
месте, где вы хотите поместить центр 
пялец. 

Настройка центра пялец 
 

Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить 
или отключить показ пялец. Щелчок 
правой кнопкой мыши  позволяет  

         изменить настройки пялец. 
 
По умолчанию BERNINA всегда размещает 
проект в центре пялец. Однако вы можете 
выбрать опцию Manual, если вы хотите 
поместить проект в другой части пялец. Вы 
можете также изменить положение центра 
пялец. 
                                                                      

Автоматическая центровка Вручную 
 
Как настроить центр пялец 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
 Появится диалоговое окно Options> 

Hoop.  

 
2 На настроечной панели Position 

выберите способ центровки пялец. 
 
◄  Automatic Centering (Автоматическая 
центровка): пяльцы перемещаются таким 
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образом, что проект всегда находится в 
центре. 
 
◄  Manual (Ручная): пяльцы остаются в 

своем первоначальном положении. 
 Выберите Set Hoop Center (Установить 

центр пялец), чтобы изменить 
положение пялец. 

 
 
3

 Щелкните по OK. 
 Если вы выбрали опцию Set Hoop 

Center, щелкните в окне проекта, в том 
месте, где вы хотите поместить центр 
пялец. 

 
Определение 
пользовательских пялец  
 
Если вы используете пяльцы с 
отсутствующими в списке размерами, вы 
можете назначить свои собственные 
пяльцы и сохранить их для последующего 
использования. Вы можете создавать или 
редактировать четыре типа пялец – 
прямоугольные, овальные, раздвижные и 3-
позиционные. 
 
Назначение прямоугольных пялец 

 
Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок 
правой кнопкой – создание пялец. 

 
Прямоугольные пяльцы отображаются 
черными пунктирными линиями. Вы можете 
назначить высоту и ширину прямоугольника 
в соответствии с размерами пялец. 
                                              Ширина 

 
 
 
 
 
 
 
Высота 
 
 
 
 
 
   

 

Как назначить прямоугольные 
пяльцы 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop. 
 
Появится диалоговое окно Options > Hoop.  
 

 
2   Нажмите кнопку New Hoop. 

Откроется диалоговое окно Create/Edit 
Hoop (Создать/Редактировать 
пяльцы). 
 

 
3 В списке Format выберите Rectangle. 
 
4  В панели Dimensions (Размеры) 

введите высоту (Height) и ширину 
(Width) прямоугольных  

пялец. 
 
5  Нажмите кнопку Save Hoop As 

(Сохранить пяльцы как) Откроется 
диалоговое окно Save Hoop As. 

6 Введите название пялец. 

 
7 Щелкните по OK и Save Hoop. 
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Назначение овальных пялец 
 
Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок 
правой кнопкой – создание пялец. 

 
Овальные пяльцы отображаются черным 
пунктирным контуром. Вы можете назначить 
высоту и ширину овала в соответствии с 
размерами пялец. 
 
 
Высота  
Прямо- 
Угольника 
         
 
 

 
 
 
 

                                                                                   
                                                       Ширина 

 
Как назначить овальные пяльцы 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
 Появится диалоговое окно Options> 

Hoop.  

 
2  Нажмите кнопку New Hoop. 

Откроется диалоговое окно Create/Edit 
Hoop (Создать/Редактировать 
пяльцы). 
 

 
 

 
3 В списке Format выберите Oval. 
4 На панели Dimensions введите высоту 

прямоугольника (Rectangle Height), 
общую высоту (Total Height) и ширину 
(Width) овальных пялец. 

5 Нажмите кнопку Save Hoop As 
(Сохранить пяльцы как)  

 Откроется диалоговое окно Save Hoop 
As. 

 
6 Введите название пялец. 
 
7 Щелкните по OK и Save Hoop. 

 
 
Назначение раздвижных пялец 
 

Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок 
правой кнопкой – создание пялец. 

 
Раздвижные пяльцы являются 
специальными пяльцами с регулируемыми 
рамками для приспособления к необычным 
размерам проекта. Вы можете назначить 
высоту и ширину пялец, а также поля 
вышивания в соответствии с размерами 
используемых пялец. 
 
 
 
 
 
Поле 
вышивания 

                                
 
 
 
 
 
                                
Ширина 

 
Как назначить раздвижные пяльцы 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
Появится диалоговое окно Options > 
Hoop.  

 

Общая 
высота 

Общая  
высота
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2 Нажмите кнопку New Hoop. 
 

Откроется диалоговое окно Create/Edit 
Hoop.  

 
3  В списке Format выберите Sliding 

(Раздвижные). 
4 В панели Dimensions (Размеры) 

введите высоту поля вышивания (Sewing 
Field), общую высоту (Total Height) и 
ширину (Width) пялец. 

 
Примечание: Лучше всего вводить в 
первую очередь общую высоту. Если 
поле вышивания больше принятой по 
умолчанию общей высоты, то 
установленный размер уменьшается. 

5 Нажмите кнопку Save Hoop As 
(Сохранить пяльцы как). Откроется 
диалоговое окно Save Hoop As. 

6  Введите название пялец. 
 

 
 
7 Щелкните по OK и Save Hoop. 

Назначение 3-позиционных 
пялец 
 

Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок 
правой кнопкой – создание пялец. 

 
3-позиционные пяльцы позволяют вручную 
разделять крупные проекты и вышивать без 
обычных проблем регистрации. 
 В отличие от раздвижных пялец поля 
вышивания находятся в фиксированной 
позиции с известными размерами, что 
облегчает регистрацию объектов, 
вышиваемых в каждой позиции. На экране 
они отображаются в виде трех 
оконтуренных пунктиром прямоугольников. 
Верхний прямоугольник зеленый, средний 
синий и нижний красный. Вы можете 
назначить собственные 3-позиционные 
пяльцы в соответствии с размерами 
используемых вами пялец. 
 
 
 
Высота 1-й 
позиции 
 
Высота 2-й 
позиции 
 
 
Высота 3-й 
позиции 

 
                                                                           
Ширина 

 
Как назначить 3-позиционные 
пяльцы 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
 Появится диалоговое окно Options> 

Hoop.  
 

 
 
2  Нажмите кнопку New Hoop. 
 

Общая  
высота 
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Откроется диалоговое окно Create/Edit 
Hoop (Создать/Редактировать пяльцы). 

 
 
3  В списке Format выберите 3-Position (3-

позиционные). 
4 В панели Dimensions (Размеры) 

введите общую высоту (Total Height), 
значения высоты для позиций 1, 2 и 3, а 
затем ширину пялец (Width). 

 
Примечание: Лучше всего вводить в 
первую очередь общую высоту. Если 
поле вышивания больше принятой по 
умолчанию общей высоты, то 
установленный размер уменьшается. 

5  Нажмите кнопку Save Hoop As 
(Сохранить пяльцы как). Откроется 
диалоговое окно Save Hoop As. 

6 Введите название пялец. 
 

 
 
7 Щелкните по OK и Save Hoop. 
 
Настройка собственных пялец 
 
 

Щелкайте по кнопке Show Hoop 
(панель General), чтобы 
включить или отключить показ 
пялец. Щелчок правой кнопкой – 
редактирование пялец. 

 
При необходимости можно изменять высоту 
и ширину новых пялец. Можно изменять 
настройки только пользовательских пялец. 
 
Как изменять настройки пялец  
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
Появится диалоговое окно Options > 
Hoop.  

 
2 В списке Hoop (Пяльцы) выберите 

пяльцы. 
Обe функции (кнопки)  Edit Hoop и 
Delete Hoop активны.  

 
Примечание:  Чтобы удалить пяльцы, 

нажмите кнопку Delete Hoop (Удалить 
пяльцы), а затем для подтверждения  
кнопку OK.  
Пяльцы будут безвозвратно удалены. 

3 Нажмите кнопку Edit Hoop 
(Редактировать пяльцы).  
Откроется диалоговое окно Create/Edit 
Hoop. 

 

 
4 Введите новые размеры. 
 
5  Нажмите кнопку Save Hoop (Сохранить 

пяльцы). 
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Настройка автоматических 
начальных и конечных точек 
 
Используйте команду Start and End (меню 
Arrange), чтобы установить начальную и 
конечную точки проекта. 
 
Перед вышиванием некоторые 
вышивальные машины потребуют от вас 
точно позиционировать иглу в месте 
первого прокола материала иглой.  
 
 
Используйте команду Start and End (Начало 
и Конец), чтобы связать первый и конечный 
стежки проекта. Это облегчит 
позиционирование иглы перед вышиванием 
и предотвратит возможность выхода иглы 
за пределы пялец. 
 
Как настроить автоматические 
начальные и конечные точки 
1  Выберите команду Arrange > Start and 

End.  
Откроется диалоговое окно Start and End. 

 
 
 
Выберите 
опцию Start 
Point  
 
 
 
 
 
 
Выберите 
опцию End 
Point  
 
 

 
2  Выберите метод Start Point 
(Начальная точка) 

►  First Stitch (Первый стежок): 
начальная точка является первым 
стежком проекта. 

►  Auto Start at (Автоматическая 
начальная точка в): Maintain 
Automatically (Поддерживать 
автоматически): начальная точка 
автоматически устанавливается у 
назначенной точки проекта - Center of 
Design (Центр проекта) или Bottom 
Middle (Середина нижней части). 
 

 
 
 
 
 
 
 
 
 
 
►  Digitize Start Point (Определить 

начальную точку): вам будет 
предложено ввести начальную точку. 

 
Примечание: Если вы также выбрали 
Digitize End Point, то вам будет предложено 
ввести конечную точку. 
 

Начальная точка:  Начальная точка 
Первый стежок:    :  Auto Start  
Конечная точка:   Конечная точка: 
Последний   Auto End,  
стежок проекта  центр проекта 
 
3  Выберите метод End Point (Конечная 

точка) 
►  Last Stitch (Последний стежок): 

последняя точка является последним 
стежком проекта. 

► Auto End at (Автоматическая 
последняя точка в): Maintain 
Automatically (Поддерживать 
автоматически): последняя точка 
автоматически устанавливается у 
назначенной точки проекта -  

► Digitize End Point (Определить 
конечную точку): вам будет 
предложено ввести конечную точку. 

4   Выберите Maintain Automatically 
(установлено по умолчанию), чтобы 
автоматически устанавливать начальную 
и/или последнюю точку.  
5  Нажмите кнопку ОК. 
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ГЛАВА 5 

 

ЦВЕТА НИТОК И ТАБЛИЦА НИТОК 
------------------------------------------- 
 

При оцифровывании вы выбираете в окне проекта цвета ниток из палитры цветов для 
каждого создаваемого объекта. Цветовая палитра содержит набор цветов ниток, 
специфицированный для каждого проекта. Эта цветовая схема представляет собой 
фактические цвета ниток, с которыми будет вышит проект. 

 
Вы можете предварительно просматривать проект в различных цветах на разных 
материалах. В действительности, вы можете просмотреть разнообразные цветовые 
схемы. Вы можете также распечатать различные цветовые схемы, разные цвета фона и 
пиктограммы цветных блоков. 
Для каждой цветовой схемы вы можете выбрать цвета из фирменных таблиц ниток, 
содержащих диапазон цветов, от различных производителей ниток или выбрать другие 
нитки. Для экономии времени при настройке новых цветовых схем вы можете создать 
собственные таблицы ниток, используя наиболее части применяемые цвета. Вы можете 
добавлять, редактировать и удалять нитки из таблицы ниток или переименовывать или 
удалять сами таблицы.  
В BERNINA ARTlink вы можете искать нужные вам нитки по различным критериям. 
В этом разделе описывается, как выбирать цвета из цветовой палитры. Здесь также 
поясняется, как определять свои собственные цвета ниток и таблицы. 

 

Подбор цветов ниток 
 
В BERNINA ARTlink вы можете вручную найти 
нужные вам нитки по различным критериям. 
Приведение в соответствие цвета нитки 
позволит вам найти и изменить цвет нитки, 
основанный на близком соответствии с одной 
или несколькими таблицами ниток. 

 
Поиск типов ниток 
 
Для поиска нитки выберите Thread Colors из 
меню Settings. 
 
Вы можете найти нитку по коду или описанию в 
диалоговом окне Thread Colors (Цвета ниток). 
 
Как найти тип нитки 
1  Выберите Settings (Настройки) > Thread 
Colors (Цвета ниток).
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 Откроется закладка Thread Colors 
диалогового окна Design Properties (Свойства 
проекта). 
 
 
 

 
 
 
 
 

Выбор  
Таблицы 

 ниток 
 
                             

Подбор 
 кода 

             
Ввод 

поисковой  
строки 

                           
Выбор критерия поиска  
 
 
2  Выберите таблицу ниток, чтобы включить в 

поиск из списка Thread Charts (Таблицы 
ниток). 

3  Выберите функцию поиска – Code (Код) или 
Description (Описание). 

 Код – это идентификационный номер цвета 
нитки в бренде. 

4  В поле Search (Поиск)  введите первые 
несколько символов требуемого кода или 
описания. 

 Система разыщет наиболее близкое 
соответствие и отобразит его в списке цветов 
нитки. 

 
Подбор ниток из различных таблиц 
 
Для подбора ниток из различных таблиц 
выберите Thread Colors (меню Settings). 
 
Вы можете найти и изменить цвет нитки, 
основанный на близком соответствии с одной 
или несколькими таблицами ниток. Вы можете 
также использовать этот метод для изменения 
цвета всех объектов. Например, изменить 
светло-зеленый цвет всех объектов на темно-
зеленый цвет. 
 
Как подбирать нитки из различных 
таблиц 
1  Выберите Settings (Настройки) > Thread 
Colors (Цвета ниток). 

 
 Откроется закладка Thread Colors 

диалогового окна Design Properties 
(Свойства проекта). 

 
        
 

 Выбор  
цвета  
для  

подбора 
  
        
 
 

    Выбор  
таблицы  

ниток 
 

Выбор  
цвета  
для  

назна. 
чения 

 
2  Выберите цвет для подбора 
3  Выберите наиболее подходящую нитку и 

назначьте ее для палитры ниток, нажав 
кнопку Assign (Назначить). 

 
 
 

 
4  Повторяйте эту операцию до тех пор, пока не 

будут подобраны все цвета, которые вы 
хотите использовать в проекте. 

 
      

 
Оригинальные   Розовый цвет   Назначен  
цвета проекта             заменен желтым   другой 
           цвет 

 
5  Нажмите кнопку ОК. 
 Система назначит проекту выбранные цвета 
ниток. 

Создание собственных таблиц 
ниток 
 
Для создания новых таблиц ниток выберите 
Thread Colors (меню Settings). 
 
Таблицы ниток – это списки предварительно 
определенных цветов ниток. Они могут быть 
основаны на фирменных таблицах ниток или на 
составленных вами таблицах. 
 
Создание новых таблиц ниток 
При создании таблицы ниток вы создаете набор 
цветов для использования в вашем проекте. 
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Как создать таблицу ниток 
1  Выберите Settings (Настройки) > Thread 
Colors (Цвета ниток). 
 Откроется закладка Thread Colors 
диалогового окна Design Properties (Свойства 
проекта). 

 
Нажмите Modify Charts 
 
2  Нажмите кнопку Modify Charts (Изменить 
таблицы). 
 Откроется диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 

Нажмите New 
   

 
3  Нажмите кнопку New (Новый). 
 Откроется диалоговое окно New Thread Chart 
(Новая таблица ниток). 
 
 Введите имя таблицы 

 
 
 
 
 
4 

 Введите имя таблицы и нажмите OK. 
Примечание: При присвоении имени для 
ваших собственных цветовых таблиц или 
отредактированных цветовых таблиц не 
используйте символы или знаки препинания, 
такие как запятые.  
Вы возвратитесь к диалоговому окну Modify 
Thread Chart. Новая таблица создана и 
готова для добавления цветов ниток. 

5  Нажмите кнопку Add (Добавить), чтобы  
      открыть окно Add Thread (Добавить нитку). 

Подробнее см. в разделе Добавление  
собственных цветов в таблицу ниток.  

      

 
6  Нажмите кнопку Copy From (Скопировать 

из), чтобы добавить цвета из существующей 
таблицы. 

 Подробнее см. в разделе Копирование 
цветов из таблицы в таблицу. 

7  Нажмите кнопку ОК. 
 Новая таблица создана и готова для  
      использования. 
 
Копирование цветов из таблицы в 
таблицу 
Вы можете копировать цвета из одной таблицы 
ниток в другую для создания собственных 
таблиц из существующих цветов. 
 

Как копировать цвета из таблицы в 
таблицу 
1  Откройте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых 
таблиц ниток. 

Выбор таблицы ниток 
   

 
       Нажмите Copy From  
2  Выберите таблицу из списка Thread Chart 
(Таблица ниток) > Name (Имя) 
3  Нажмите кнопку Copy From… 
(Скопировать из      …)  Откроется 
диалоговое окно Copy From.  

 
4  Из списка Name выберите таблицу ниток,  
      содержащий цвет, который вы хотите 
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копировать. 
5  Выберите цвет, который вы хотите 

копировать, затем нажмите OK. 
 Цвет будет скопирован в таблицу ниток и 

появится в конце списка. 
 
Добавление собственных цветов в 
таблицу ниток 
Вы можете добавлять цвета в таблицы ниток из 
других таблиц или самостоятельно смешанных 
цветов,  
 
Как добавить собственные цвета в 
таблицу ниток 
1  Откройте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых 
таблиц ниток. 
2  Нажмите кнопку Add, чтобы добавить 
собственные цвета. 
 Откроется диалоговое окно Add Thread 
(Добавить нитку). 
3  Смешайте отображаемый цвет нитки. 
 Подробнее см. в разделе Смешивание ваших 
собственных таблиц ниток. 
4  Введите код, бренд и опишите детали для 
нового цвета нитки. 
 Код – это идентификационный номер цвета 
нитки в бренде. 
5  Нажмите кнопку ОК. 
 Новый цвет появится в списке Threads 
(Нитки). 
Смешивание ваших собственных 
цветов ниток 
Вы можете изменить цвет, который 
отображается для частичной нитки или создайте 
новые цвета ниток, используя диалоговое окно 
Color (Цвет). 
 
Как смешивать ваши собственные цвета 
ниток 
1  В диалоговом окне Add Thread (Доьавить 

нитку) или Edit Thread (Редактировать 
нитку). нажмите кнопку Mix (Смешать). 

◄ Подробнее см. в разделе Добавление 
собственных цветов в таблицу ниток. 

◄ Подробнее см. в разделе Изменение 
характеристик нитки. 

 Откроется окно Color (Цвет).. 
 

Передвиньте ползунок  
для регулировки яркости цвета 

 
2  Из таблицы Basic colors (Основные цвета) 

выберите цвет, который ближе всего 
подходит к нужному вам цвету. 

3  Щелкните мышью и перетащите перекрестие 
нитей по спектру цветов, чтобы получить 
требуемый вам цвет. 

4  Передвиньте ползунок на правой стороне 
окна цветового спектра, чтобы 
отрегулировать яркость цвета. 

 В правом нижнем углу диалогового окна Color 
появятся значения HLS (Цвет-Яркость-
Насыщенность) и RGB (Зеленый, Красный, 
Синий). Введите эти значения для точного 
определения цветов. 

5  После смешивания требуемого цвета 
нажмите кнопку Add to Custom Colors 
(Добавить к пользовательским 
цветам). 

6  Нажмите кнопку ОК. 
 Новый цвет появится в окне просмотра Color  
      (Цвет). 

Изменение таблиц ниток 
 
Обновление существующих таблиц ниток путем 
изменения характеристик ниток или удаления 
отдельных ниток. Вы можете также 
переименовывать или удалять таблицы ниток. 
 
Изменение характеристик нитки 
Изменение кода, бренда или описания 
существующей нитки. 
 
Как изменить характеристики нитки 
1  Откройте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых 
таблиц ниток. 
 
 

 
Выбор 

таблицы 
ниток 

 
 
 

Выберите 
нитку для  
изменения 

 
 
 
2  Из 
списка Name (Имя) выберите таблицу для 
изменения. 
3  Из списка Threads (Нитки) выберите нитку 
для изменения. 
4  Нажмите кнопку Edit (Редактировать). 
 Откроется диалоговое окно Edit Thread 
(Редактировать нитку). 
5  Измените характеристики нитки, как вам 
требуется. 
 Подробнее см. в разделе Добавление 
собственных цветов в таблицу ниток. 
6  Нажмите кнопку ОК. 
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Удаление ниток из таблиц 
 
Для удаления ниток из таблиц выберите Thread 
Colors (меню Settings). 
 
Вы можете легко удалить ненужные цветные 
нитки из таблицы ниток, используя диалоговое 
окно Modify Charts (Изменить таблицы). 
 
Как удалять нитки из таблиц 
1  Откройте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых 
таблиц ниток. 

 
 
 
 
 
Нажать для  
удаления  
выбранного  
цвета 
 
 
 
Нажать для  
удаления  
ВСЕХ 
цветов 
 
 
 

 
2  Из списка Name (Имя) выберите таблицу для 
изменения. 
3  Из списка Threads (Нитки) выберите нитку 
(или нитки) для удаления.  
4  Нажмите кнопку Remove (Удалить). 
 Появится требование подтвердить удаление. 
5  Нажмите Yes (Да). 
 
Совет: Для удаления всех ниток из таблицы 
нажмите кнопку Clear All (Удалить все). 
 
Переименование таблиц ниток 
 
Для переименования таблиц ниток выберите 
Thread Colors (меню Settings). 
 
Для переименования таблиц ниток используйте 
диалоговое окно Modify Thread Chart (Изменение 
таблицы ниток). 
 
Совет: Выбирайте имена, которые помогут вам 
вспомнить, какая таблица вам требуется, или 
таким образом, чтобы наиболее часто 
используемые таблицы находились в верхней 
части списка. 
 
Как переименовывать таблицы ниток 
1  Откройте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых 
таблиц ниток. 

 
Выбор таблицы ниток    Нажать для изменения 
                                         имени 

 
2  Из списка Name (Имя) выберите таблицу для 
изменения. 
3  Нажмите кнопку Rename 
(Переименовать). 
 Откроется диалоговое окно Rename Thread 
Chart (Переименовать таблицу ниток). 
 

Измените имя таблицы 
 
4  Введите новое имя для таблицы ниток, затем 
нажмите OK. 
 
Удаление таблиц ниток 
 
Для удаления таблиц ниток выберите Thread 
Colors (меню Settings). 
Для удаления ненужных таблиц ниток 
используйте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 
Примечание: Соблюдайте осторожность при 
удалении таблиц ниток. Если вы удалите по 
ошибке нужную таблицу, то вам потребуется 
перезапустить BERNINA artista, чтобы 
восстановить ее. 
 
Как удалять таблицы ниток 
1  Откройте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых 
таблиц ниток. 

 
Выбор таблицы ниток   Нажать для  

 удаления выбранной 
таблицы 

 
2  Из списка Name (Имя) выберите таблицу для 
удаления. 
3  Нажмите кнопку Delete (Удалить). 
 Появится требование подтвердить удаление. 
4  Нажмите Yes (Да). 



Глава 6: Расположение и трансформация объектов 
 

BERNINA® Вышивальное ПО ARTlink 6 28

 
ГЛАВА 6 

 

РАСПОЛОЖЕНИЕ И 
ТРАНСФОРМАЦИЯ ОБЪЕКТОВ 

------------------------------------------- 
 

BERNINA ARTlink позволяет изменять положение, размер и ориентацию объектов в 
проекте путем их перемещения, изменения размеров и трансформации. Вы можете 
модифицировать объекты непосредственно на экране  
 
 

 
В этом разделе описывается, как позиционировать объекты, а также как изменять 
размеры, изменять наклон и зеркально отображать объекты.  
 
Примечание: Возможность изменения размера и качество вышивки по проекту в 
конечном счете зависит от формата первоисточника – ART Grade A, ART Grade B, ART 
Grade C или ART Grade D. Только проекты в "родном" формате ART Grade A содержат 
полный набор информации, требуемой для 100%-ного совершенства масштабирования и 
трансформации. 

 

Позиционирование объектов 
Позиционируйте объекты в вашем проекте, 
используя мышь для перетаскивания их в новое 
положение или используйте клавиши со 
стрелками для "подталкивания" объекта к 
нужной позиции. 
 

 
Щелкните при необходимости по 
инструменту  Выбор объекта на панели 
Edit (по умолчанию этот инструмент  

         активен) и щелкайте по объектам для  
         выделения. 

 

 
Как позиционировать объекты  
1  Выберите объект/ы для перемещения. 

Подробнее см. Выбор объектов.    
2  Перетащите мышью объект в новое 

положение. 
 
 
 
 
Курсор в виде 
перекрести в 
центре объекта 
 
 
 

 
3  Для более точного позиционирования 

нажимайте клавиши со стрелками, чтобы 
"подтолкнуть" объект к требуемой позиции. 
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Совет: Увеличьте масштаб изображения, 
чтобы было легче выполнять малейшие 
перемещения. Размеры объекта на экране 
изменяются в зависимости от текущего 
масштаба. Чем больше масштаб, тем на 
меньшее расстояние можно перемещать 
объект. 

Изменение размеров объектов 
 
Вы можете изменять размеры объектов путем 
перетаскивания меток – манипуляторов 
выделения. 
При изменении размеров объекта изменяется 
количество стежков для сохранения интервала 
между стежками. 
 
Примечание: Только проекты в "родном" 
формате ART содержат полный набор 
информации, требуемой для 100%-ного 
совершенства масштабирования и 
трансформации. 
 
Изменение размеров объектов 
инструментом Scale by 20% Down/Up 

 
 Щелкните по значку Scale by 20% 
Down/Up (панель Edit), чтобы изменить 
размеры объектов на 20 %. 

 
Используйте эту технику, если вы хотите быстро 
выполнить изменения, которые не требуют 
особой точности. 
           

 
уменьшение на 20 %  

оригинальный размер   
увеличение на 20 % 

 
Как изменять размеры объектов 
инструментом Scale by 20% Down/Up 
1  Выделите объект/ы. 
2  Щелкните по значку Scale by 20% Down/Up. 

◄ Щелкните левой кнопкой мыши, чтобы 
уменьшить проект на 20 %. 

◄ Щелкните правой кнопкой мыши, чтобы 
увеличить проект на 20 %. 

 
Изменение размеров объектов 
перетаскиванием мышью 

 
Используйте инструмент Выбор объекта 
(панель Edit) для изменения размеров 
проектов перетаскиванием мышью. 

 

 
Вы можете изменить высоту и ширину объекта 
или пропорционально изменять размеры 
объекта, используя маркеры – манипуляторы 
выделения.  
 
Как изменять размеры объектов 
перетаскиванием мышью 
1  Выберите объект/ы для изменения размеров. 
 Вокруг выделенного объекта появятся восемь 

меток – манипуляторов выделения. 
2  Перетащите мышью манипулятор, чтобы 

изменить размер объекта 

    
Перетащить    Shift + Перетащить 
пропорциональное  пропорциональное  
изменение     изменение размеров 

 размеров относительно  
центра 

 
◄ Для пропорционального изменения 

высоты и ширины используйте угловые 
маркеры 

 
Изменение по вертикали 
 
 
 
 
 
 
 
 

◄ Для изменения высоты используйте 
верхний средний или нижний средний 
маркеры. 

  
 
 
 
 
 

 
Изменение по горизонтали 

 
 

◄ Для изменения ширины используйте 
средние боковые маркеры. 

 
 
 
 
        
   

 
 
 
 
 
 

Изменения по вертикали       Изменения по  
в обоих направлениях    горизонтали 

        в обоих направлениях 
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Совет: Для изменения размеров 
относительно центра во время 
перетаскивания маркера удерживайте 
нажатой клавишу Ctrl + Shift.  

 

Вращение объектов 
Вы можете поворачивать объекты 
непосредственно на экране перетаскиванием 
мышью или щелкните по значку Rotate 
CCW/CW (Поворот против часовой стрелке/по 
часовой стрелке). 

 
Вращение объектов инструментом 
Rotate CCW/CW 
 

Щелкните левой кнопкой по значку 
Rotate CCW/CW (панель Edit), чтобы 
повернуть объект или проект на 45° по 
часовой стрелке. 

Щелкните правой кнопкой по значку Rotate 
CCW/CW (панель Edit), чтобы повернуть объект 
или проект на 45° против часовой стрелки. 
 
Используйте инструмент Rotate CCW/CW 
(Поворот против часовой стрелке/по часовой 
стрелке) на панели Design, чтобы поворачивать 
объекты на 45° в обоих направлениях. 
 
Как вращать объекты инструментом 
Rotate CCW/CW 
1  Выберите объект. 
2  Выберите объект инструментом Select Object 

(Выбор объекта). 
 
2  Щелкните по значку Rotate CCW/CW на 

панели инструментов.  
◄ Щелчок правой кнопкой – поворот на 45° 

по часовой стрелке. 
◄ Щелчок левой кнопкой – поворот на 45° 

против часовой стрелке. 
 
 
 
Вращение объектов 
перетаскиванием мышью 

 
Используйте инструмент Выбор объекта 
(панель Edit) для поворота  
проектов перетаскиванием мышью. 

 
Как поворачивать объекты 
перетаскиванием мышью 
1  Выберите объект/ы для поворота. 
2  Щелкните по объекту еще раз. 
 На углах объекта появятся маркеры 

вращения, а в его центре отобразится 
местоположение анкера. 

       маркер наклона 
      
маркер вращения  
      

местоположение анкера 
первым щелчком   после второго щелчка 
отображаются    появляются маркеры  
маркеры выделения вращения 

3  При необходимости перетащите анкер 
вращения в другое положение. 

4  Щелкните по маркеру вращения и 
перетащите его по часовой стрелке или 
против часовой стрелки. Во время поворота 
появляется контур и перекрестие. 

     

 
Перетащите   Перетащите   Перетащите 
угол, чтобы  анкера    угол, чтобы  
повернуть   местоположение   повернуть 
объект вокруг        объект вокруг 
анкера.         анкера. 

 

Перекос объектов 
Вы можете перекосить объект относительно 
горизонтальной линии, щелкнув по маркеру 
перекоса и перетащим его на требуемый угол. 
 

 
Перекос объекта  
перетаскиванием мышью 
 
Как перекосить объекты 
перетаскиванием мышью 
1  Выберите объект/ы для перекоса. 
2  Щелкните по объекту еще раз. 
 Вокруг объекта появятся маркеры поворота и 

перекоса. Маркеры перекоса имеют форму 
ромба и появляются в средних точках 
верхнего и нижнего края объекта. 

3  Перетащите маркер перекоса влево или 
вправо. 
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 Объект будет перекошен в горизонтальном 
направлении. Контур и перекрестие покажут 
изменение формы объекта. 

 
Перетащите маркер перекоса  
влево или вправо. 

 
 
 

 

 

Перевод объектов в 
зеркальное отображение 
 

 
Щелкните по кнопке Mirror Horizontal 
(панель Edit), чтобы перевернуть 
объект на горизонтальной оси. 
 
 
 
Щелкните по кнопке Mirror Vertical 

(панель Edit), чтобы перевернуть объект на 
вертикальной оси. 
 
Вы можете зеркально переворачивать объекты 
на горизонтальной или вертикальной оси, 
используя инструмент Mirror Horizontal или Mirror 
Vertical. 
 
Как переводить объекты в зеркальное 
отображение  
1  Выберите объект/ы для зеркального 

переворачивания. 
 
Вы можете зеркально отображать объекты, 
переворачивая их по горизонтали или по 
вертикали, используя инструменты Mirror в 
диалоговом окне Object Properties (Свойства 
объекта). 
 
                        оригинальный объект      
 зеркальное отображение по горизонтали (X) 
                                     

 
зеркальное отображение  зеркальное отображение 
по вертикали (Y)  по горизонтали и вертикали 

      (X и Y) 
2  Щелкните по значку Mirror Horizontal, чтобы 

перевернуть объект по горизонтали, или 
Mirror Vertical,  чтобы перевернуть объект по 
вертикали. 

 
 



Глава 7: Установка аппаратных средств и настройка системы 

BERNINA® ARTlink Версия 5 32

 
ГЛАВА 7 

 

УСТАНОВКА АППАРАТНЫХ СРЕДСТВ 
И НАСТРОЙКА СИСТЕМЫ 

------------------------------------------- 
 

Для работы с BERNINA ARTlink вам необходимо подсоединить периферийные 
устройства. К ним относятся, например, принтеры и вышивальные машины. 
BERNINA ARTlink позволяет настраивать различные установки системы, управляющие 
внешним видом проектов на экране, отображением информации о проекте, поведением 
окна проекта, и другие установки. 
 

 
В этом разделе описывается, как настраивать вышивальные машины и как калибровать 
монитор. Кроме того, объясняется, как изменять интервал сетки и опции 
позиционирования и изменять опции пялец. Имеется также информация о том, как 
настраивать отображение указателя мыши и как установить опцию автосохранения. 

 

Установка аппаратных средств 
 
Различные устройства устанавливаются 
различными способами – некоторые в ОС 
Windows через Панель управления, другие 
в самой программе BERNINA ARTlink. За 
указаниями по подключению устройств к 
компьютеру и их настройке в системе 
Windows обратитесь к прилагаемым к 
устройствам инструкциям, а также к 
документации по Microsoft Windows. 
 
Настройка подсоединения 
периферийного устройства 
Периферийные устройства, такие как 
принтеры, подсоединяются к имеющемуся 
порту на передней или задней стороне 
компьютера. Это может быть 
последовательный, параллельный или USB 
порт. Конфигурацию программного 
обеспечения нужно выбирать через Панель 
управления системы Windows. 
 
 
 
 

 
Настройка последовательного порта 
Последовательные COM-порты компьютера 
имеют ответные 9- или 25-штырьковые 
разъемы. Они называются COM1, COM2 и 
т.д.  Количество имеющихся портов 
ограничивает количество подключаемых 
устройств. Если требуются дополнительные 
порты, вы можете их добавить. BERNINA 
ARTlink дает возможность иметь до 4 
последовательных портов. 
 
Примечание: Вы должны уметь 
идентифицировать порты вашего 
компьютера. При возникновении сомнений 
проконсультируйтесь со специалистом. 
 
Настройка параллельного порта 
Параллельные порты используются для 
подсоединения принтера и сканера. Они 
называются LPT1, LPT2 и т.д.  
 
Настройка USB-порта 
Порты USB (Universal Serial Bus) 
используются например для подсоединения 
Вашей вышивальной машины.
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Настройка вышивальных машин 
Ваша вышивальная машина BERNINA должен 
быть подключена к порту COM1, COM2, COM3, 
COM4 или USB вашего компьютера. Подробно о 
подключении машины к компьютеру можно 
узнать в Руководстве по эксплуатации вашей 
вышивальной машины. 
 
Настройка принтеров 
Ваш принтер подключен к USB- или 
параллельному порту. BERNINA ARTlink 
использует выбираемый по умолчанию принтер, 
назначенный в парке Printer (Принтер) в Панели 
управления Windows. Руководствуйтесь 
инструкцией по принтеру, чтобы обеспечить 
правильную настройку. Воспользуйтесь 
Справкой Windows (Пуск > Справка > Указатель, 
затем выберите Принтер по умолчанию), чтобы 
получить указания по установке принтера по 
умолчанию. 

Калибровка монитора 
 
Используйте команду Display Setup (меню 
Settings) для калибровки монитора.  
 
Вам потребуется откалибровать монитор, так 
чтобы проект отображался в масштабе 1:1 в 
натуральную величину. Это необходимо в том 
случае, когда вы впервые устанавливаете 
BERNINA ARTlink или по какой-либо причине 
меняете монитор.  
 
Как калибровать монитор 
1 Выберите Settings (Настройки) > Display 
Setup (Настройка монитора). 
 Откроется диалоговое окно Screen Calibration 
(Калибровка экрана). 

Измеренная  
высота 

 
 
 
 

 
 
 
 

Измеренная ширина 
 
2 Измерьте высоту и ширину диалогового окна. 
3 Введите измеренные значения в поля Width 
(Ширина) и Height (Высота). 
4 Нажмите кнопку ОК. 
 

Настройка опций сетки 
 
Щелкните правой кнопкой мыши по 
кнопке Show Grid (панель General) 
для установки базисной точки сетки и 
интервала. 

 
Вы можете включить или выключить показ сетки, 
изменить интервал сетки или установить 
базисную точку.  
 

Выровняйте сетку со специфичной точкой в 
проекте путем установки базисной точки, 
например, если вы хотите, чтобы линии сетки 
пересекали центральную точку проекта или 
чтобы горизонтальная линия сетки находилась 
под определенным объектом. 
 
 
Как настраивать опции сетки 
1 Щелкните правой кнопкой мыши по значку 
Show Grid (Показать сетку). 
 Откроется диалоговое окно Options (Опции) с 
открытой закладкой Grid (Сетка). 
 
 

Выберите для  
отображения сетки 

 
 

Выберите для  
выравнивания сетки 

по точке 
 

Введите 
горизонтальный  
и вертикальный 

интервалы 
 
 

 
2 Проставьте флажок в окошке Show Grid, 
чтобы отобразить сетку. 
3 Проставьте флажок в окошко Set Reference 
Point (Установить базисную точку). 
 

Например, вы можете установить базисную 
точку сетки в центре проекта. Это более 
простая и быстрая операция, чем 
перемещение всего проекта. 

4 Введите значения интервала сетки (Grid 
Spacing) для горизонтальных и вертикальных 
линий. 
5 Нажмите кнопку ОК. 

Если вы выбрали опцию Set Reference Point, 
наметьте базисную точку на вашем проекте. 
Сетка будет выровнена, так что 
горизонтальные и вертикальные линии сетки 
пересекались в этой точке. 
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Настройка опций 
автоматической прокрутки 
 
При выполнение оцифровки, вы можете 
использовать функцию Auto Scroll для 
автоматического перемещения изображения 
проекта («прокрутка»). Это может быть более 
удобным, чем использование функций 
панорамирования или полос прокрутки. 
 
Для настройки опций автоматической 
прокрутки: 
1 Выберите позиции меню  Settings > Options и 
далее закладку Auto Scroll. 
 

 
 
2 Поставьте галочку в окошко метки Auto Scroll. 
 
3 Поставьте галочку в окошко метки Move 
Pointer After Scroll. Позиция пойнтера после 
каждого смещения изображения тоже будет 
смещаться. 
 
4 Укажите требуемое число в поле Autoscroll 
Response. Чем меньше число – тем выше 
скорость «прокрутки». 
 
5 Выберите положение пойнтера после сдвига из 
списка Move Input Point To: 
 
 
Option 
Положение 

Purpose 
Когда использовать 

В центре Пойнтер помещается в центре 
окна. Эту опцию удобно 
использовать при больших 
перемещениях. 
 

На пол-
пути 

Пойнтер помещается на пол-пути 
между его текущим положением и 
центром окна. 
Эту опцию удобно использовать 
при небольших перемещениях – 
например при масштабировании 
для работы с маленькой областью 
образца. 
 

В углу Пойнтер помещается на краю 
экрана. Эту опцию удобно 
использовать при медленном 
перемещении. 
 

 

 
6 Нажмите OK. 
Настройки будут применены только тогда, когда 
вы начнете выполнять оцифровку.  Экран 
проекта Design Window автоматически 
смещается в след за текущим положением 
курсора. 
 
Подсказка: Удерживая в нажатом положении 
клавишу Shift, можно временно отключить 
функцию Auto Scroll. 
 

Настройка опций пялец 
 

Щелкните правую кнопкой мыши 
инструмент Hoop (панель General) для 
изменения настроек пялец. 

 
Имеется определенный диапазон размеров 
подбора к размеру проекта, а также к числу 
вышивальных машин. Рекомендуется выбирать 
наименьший размер пялец, который будет 
соответствовать размеру проекта. Благодаря 
этому ткань в время вышивания будет 
оставаться плотно натянутой.  

             
 
Как настраивать опции пялец 

◄ Щелкните правой кнопкой мыши по 
значку Show Hoop (Показать пяльцы). 
Появится диалоговое окно Options с 
открытой закладкой Hoop (Пяльцы).  
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Совет: Для скрытия пялец уберите флажок 
из окошка Display Hoops (Показать пяльцы). 

2 Выберите пяльцы из списка Hoop. 
 Выберите положение пялец на панели 
Position.  

Подробнее см. в разделе Настройка центра 
пялец. 

3 Нажмите кнопку New Hoop (Новые 
пяльцы) для создания  
      собственных пялец. 

Подробнее см. в разделе Создание 
собственных пялец. 

4 Нажмите кнопку Edit Hoop (Изменить 
пяльцы) для  изменения существующих пялец. 

Подробнее см. в разделе Редактирование 
собственных пялец. 

5 Нажмите кнопку Delete Hoop (Удалить 
пяльцы) для удаления существующих пялец. 

Подробнее см. в разделе Удаление пялец. 
6 Нажмите кнопку ОК. 
 
Настройка общих опций 
 
BERNINA ARTlink позволяет настраивать 
различные общие установки, управляющие 
автосохранением проектов, определения 
положения указателя мыши на экране, а также 
отображением единиц измерения. 
 
Установка функции автоматического 
сохранения 
 
Выберите Options (меню Settings) для установки 
опций автосохранения и создания резервных 
копий  
 
Сохраняйте свою работу автоматически с 
регулярными интервалами, используя функцию 
Auto Save (Автосохранение) для защиты от 
потери при сбое аппаратных или программных 
средств.  
Резервная копия файла создается каждый раз 
при сохранении проекта. Проект сохраняется в 
папке BACKUP программы BERNINA ARTlink. 
Копия имеет то же имя, что и оригинальный 
файл, но с расширением BAK. 
 
Внимание: Резервные копии файлов остаются в 
папке BACKUP до тех пор, пока вы не удалите 
их. Чтобы эта папка не занимала слишком много 
места на жестком диске, регулярно удаляйте 
ставшие не нужными резервные файлы. 
 
 
Как установить опцию автосохранения 
1 Выберите закладку Settings > Options > 
General. 

 
 

Введите интервал автосохранения 
 
2 Проставьте флажок в окошке Save Design 
(Сохранять  
     проект) 
3 Введите в поле Auto Save Period интервал 

автосохранения в минутах. 
4 Нажмите кнопку ОК. 
 
Интерпретация положения указателя 
мыши 
Значения X и Y показывают горизонтальное (X: 
horizontal) и вертикальное (Y: vertical) расстояние 
указателя от относительной или абсолютной 
отметки. Значение L – это длина линии, 
соединяющей указатель с предыдущей точкой, а 
A – это угол наклона этой линии по отношению к 
горизонтали. 
 

длина = 30,1 мм 

 
                         X: горизонталь          L: длина   A: угол 
                           Y: вертикаль     
 
Отрицательное 
значение величины X 
означает, что вторая 
точка расположена 
слева от первой точки, 
в том время как 
отрицательное 
значение величины Y 
означает, что вторая 
точка находится ниже 
первой. 
Отрицательные 
значения углов 
означают, что угол 
больше 180°, 
например, угол -60° 
равен углу 300°.  
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Совет: Вы можете измерять расстояния на 
экране, пользуясь величинами в статусной 
строке. Подробнее см. в разделе Измерение 
расстояний на экране. 
 
Настройка опций отображения 
положения указателя мыши 
 
Выберите команду Options (меню Settings) для 
установки опций отображения положения 
указателя мыши.  
 
Когда вы перемещаете мышь, положение 
указателя отображается в статусной строке в 
нижней части экрана. Вы можете факультативно 
отображать положение указателя относительно 
последней оцифрованной точки или точки 
стежка или как абсолютное значение от первой 
точки укола иглой в проекте. 
 
Как настраивать опции отображения 
положения указателя мыши 
1 Выберите закладку Settings > Options > 
General. 

 
 

 
 

Выберите  
относительное  
или абсолютное  
положение  
указателя 
 
2 Выберите Relative (Относительную) или 
Absolute (Абсолютную) установку указателя.  

◄ Relative: показывается положение 
указателя относительно последней 
оцифрованной точки или точки стежка. 
Полезно во время оцифровывания или 
редактирования стежков. 

◄ Absolute: показывается положение 
указателя в абсолютных единицах от 
первой точки укола иглой в проекте. 
Полезно для проверки соответствия 
проекта имеющейся площади.  

. 
Скрытие всплывающей подсказки 

инструмента Measure  
 
Выберите Options (меню Settings) для 
отображения всплывающей подсказки Show 
Measure  
 
Инструмент Measure (Измерить) отображает 
координаты, расстояние и угол указателя мыши 
от точки, соответствующей центру пялец в 
пустом проекте. Вы можете показывать или 
скрывать эти измерения, используя опцию Show 
Measure Tooltip (Показывать всплывающую 
подсказку измерений). 
 
Как скрыть всплывающую подсказку 
инструмента Measure  
1 Выберите закладку Settings > Options > 
General. 
 

                    
Выберите Show  
Measure Tooltip 
 
 
 
2 Проставьте флажок в окошке Show Measure 
Tooltip, чтобы включить опцию всплывающей 
подсказки.  
 
 

 

3 Нажмите кнопку ОК 
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ГЛАВА 8 

 

ВЫВОД И СОХРАНЕНИЯ ПРОЕКТОВ 
------------------------------------------- 

Вы можете выводить проекты вышивок различными способами – распечаткой в виде 
рабочих документов, в виде выкроек аппликаций, цветных слайдов или таблиц ниток. 
BERNINA Embroidery Software позволяет также сохранять проекты 
как изображения с тканью и деталями одежды. Вы можете также 
непосредственно направить проект в машину.  
Когда вы отправляете проекты непосредственно в машину для 
вышивания, они могут быть потеряны после отключения машины. 
Чтобы сохранить проекты, записывайте их в память машины или 
на карте памяти или сохраняйте на жестком диске ПК, на 
компакт-диске или USB-Stick.  
 
В этом разделе описывается,  как распечатывать рабочие 
документы, выкройки аппликаций, цветные слайды и таблицы 
ниток. Здесь также рассматривается порядок передачи и записи проектов в машину, а 
также считывания их из машины. 

 
Распечатка проектов 

 
Используйте инструмент Print Preview 
(панель General) для просмотра 
проекта перед печатью. 
 
 
 
 
Используйте кнопку Print (панель 

General) для печати проекта. 
 
 
Используйте функцию Print Preview для 
просмотра информации о вышивании. Проверьте 
последовательность вышивания перед 
вышиванием проекта, так как вам нужно знать 
последовательность цветных фрагментов. Вы 
можете создать бумажную копию ваших 
проектов, используя стандартные или 
пользовательские настройки принтера 
 

Предварительный просмотр и 
распечатка проектов 
1 Нажмите кнопку Print Preview 
(Предварительный просмотр). 

 
Ваш проект откроется в том виде, в котором 
он будет отпечатан. Большие проекты могут 
изображаться на нескольких страницах в 
случае их распечатки в фактическом размере.  
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2 Используйте команды Preview при 

необходимости:: 
- Next Page  = посмотреть следующую  
  страницу, 

       -Prev Page = посмотреть предыдущую  
        страницу)  
      - Two Pages (Две страницы) = для  
         просмотра нескольких страниц. 
       - Portrait/Landscape: Переключение между  
         портретной и альбомной ориентацией  
         страницы. 
- Щелкните по значку Zoom In/Out, чтобы 

проверить детали проекта или прочитать 
рабочую   
  информацию. 

3  Щелкните по кнопке Options, чтобы выбрать 
опции печати.  
Подробнее см. в разделе Настройка печати 
вышивальных файлов.. 

4  Щелкните по кнопке Print Now, чтобы 
пристурть к процессу печати. Откроется 
диалоговое  
окно Print операционной системы MS 
Windows®, позволяющее выбрать принтер и 
выбрать  
желаемые настройки печати.  См. также 
Настройка опций печати вышивальных 
файлов.   

5  Нажмите Close, чтобы вернуться к окну 
Design  

 
Настройка опций печати 
Настройки печати позволяют детально выбрать 
вид распечатанного проекта. 
Вы можете распечатать копию вашего проекта с 
информацией относительно размеров проекта, 
последовательности вышивания цветных 
фрагментов, количества стежков вместе с 
изображением проекта.  
 
Предусмотрены опции, позволяющие включить 
или исключить из распечатки в режиме 
просмотра 
Artistic View крестики, отмечающие начальную и 
конечную точки, соединительные точки, 
цвет/ткань фона  
и текущие пяльцы. Информация о проекте 
включает данные об авторе,  расчетную длину 
верхней нитки для каждого цвета и общую длину 
нижней нитки. 
 
Как настраивать опции печати 
1 Откройте диалоговое окно Print (Печать). 
      Откроется диалоговое окно Print. 
       

 

2 Выберите принтер из списка Name. 
3 Укажите количество копий, которые 

необходимо распечатать и остальную 
информацию о печати. 

4 Выберите Options (Опции), если нужно 
изменить размер изображения, тип просмотра 
или включаемые в распечатку детали. 

 Откроется диалоговое окно Print Options 
(Опции печати). 

       
 

  
  
 
 
 
 
 
 
 
 
 
 
5 На панели Elements (Элементы) выберите 

Embroidery (Вышивка), если еще не выбрано.  
Все вышивальные стежки показываются по 
умолчанию в нормальном режиме просмотра 
(Design View). 

 
Примечание: Опция Выбранные объекты 
(Selected Objects) в программе BERNINA ARTlink 
не доступна. 
 
6  Выберите Artistic View, чтобы распечатать 

проект в режиме Художественного 
Просмотра. 

7  Включите другие опции, если необходимо: 
¢Hoop (Пяльцы):  В распечатку включаются 
пяльцы. 
 

 
 

Печатать 
только весь 

проект

Выбрать для 
печати элементы 

вышивки



Глава 8: Вывод и сохранение проектов 

BERNINA® Вышивальное ПО ARTlink 6 39

 
¢Connectors (Соединительные стежки): Все 
соединительные стежки проекта отображаются, 
даже если текущая опция Selection (Выбор) 
установлена на Selected Objects (Выбранные 
объекты). 

 
Примечание: В режиме просмотра Artistic View 
опция Connectors (Соединительные стежки) не 
действует,  т.е. вы не сможете увидеть их в этом 
режиме. 
Start/End Crosshair (Перекрестия в 
начале/конце): В распечатку включаются 
начальная и конечная позиции иглы. 
Background Color/Fabric (Фон Цвет/Ткань): Фон 
страницы заполняется цветом в соответствии с 
настройкой фона (Background). Подробнее см. в 
разделе Изменение фона. 
 

8 Выберите опцию размера на панели Size: 
◄  Actual Size: проект будет распечатан в 

том же размере, в котором он будет 
вышит. 

◄ Fit to Page: крупный проект будет 
уменьшен до размера печатной страницы, 
а небольшой проект – соответственно 
увеличен.  

 
◄ % of Actual: Размеры изображения 

проекта изменяются в соответствии с этой 
настройкой.  

 

 
9  Нажмите кнопку ОК. 
 
 
 
Распечатка выкроек аппликации 
Распечатайте копию узора аппликация для 
использования  в качестве шаблона для 
вырезания мотива аппликации из материала.  
Каждый узор аппликации нумеруется в 
соответствии с последовательностью 
вышивания. 
 
Как распечатать узор аппликации 
1  Выберите File > Print Preview.  
2  Щелкните по значку Options. 
Откроется диалоговое окно Print Options. 
 
3  Выберите опцию Applique Pattern. 

                                           
4  Щелкните по ОК..

Выберите для
распечатки

выкроек
аппликации
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Каждый элемент аппликации нумеруется в 
соответствии с последовательностью 
вышивания.  
 

 
Примечание: Если выбрана опция Actual Size 
(Фактический размер), то как скомпонованная 
аппликация, так и индивидуальные выкройки 
создаются на отдельных страницах. Если 
выбрана опция Fit to Page или % of Actual, то 
скомпонованная аппликация создается в 
выбранном размере, но индивидуальные 
выкройки печатаются в фактическом размере на 
отдельных страницах. 
 
5  Щелкните по кнопке Print. 
 
Распечатка таблицы Color Film 
Опция Color Film позволяет вам включить список 
цветных слоев текущего проекта вместе с 
информацией о цвете и стежках для каждого 
слоя. 
 
Как распечатать таблицу Color Film 
1  Выберите File > Print Preview. 
2  Щелкните по значку Options. 
 Откроется диалоговое окно Print Options 

(Опции печати). 

 
3  Выберите опцию Color Film. 
                        

 
 

 
4  Щелкните по ОК. 

Будет включена следующая информация: 
• Number: Номер в последовательности 

вышивания  
• Color: Название цвета в соответствии с 

таблицей ниток. 
• Code: Код нитки для заказа. 
• Brand: Марка нитки, например Isacord 40. 
• Stiches: Общее количество стежков для 

индивидуального цветного слоя. 
• Thread Used: Общая длина стежков в 

индивидуальном цветном слое в 
соответствующих  
принятых в системе единицах измерения, 
например в метрах. 

 
Примечание: Отображаемая здесь информация 
является той же информацией, которая 
отображена в диалоговом окне Thread Colors 
(Цвета ниток).  Подробнее см. в разделе Подбор 
цветов ниток. 
                                   

 

Страница выкроек 
аппликации 

Страница 
скомпонованной 
аппликации 

Подробно о 
цвете ниток

Выбрать для 
печати таблицы 

Color Film
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5  Щелкните по Print. 
 
Распечатка таблиц ниток 
 
Выберите Thread Colors (меню Settings) для 
распечатки таблиц ниток.  
 
Опция Thread Chart > Print (Таблица ниток > 
Печать) позволяет распечатать список ниток в 
таблице ниток как справка для приобретения 
ниток 

Как распечатать таблицу ниток 
1  Выберите Settings (Настройки) > Thread 

Colors (Цвета ниток). 
 Откроется диалоговое окно Design Properties 

(Свойства проекта > Thread Colors (Цвета 
ниток).  

 
 
 
 
 
 
 
 
2  Выберите таблицу из списка Thread Chart 

(Таблица ниток). 
3  Щелкните по кнопке Print (Печать). 
Откроется страница Print Preview 
(Предварительный просмотр), отображающая 
распечатываемую форму выбранной таблицы 
ниток в текущей рассортированной 
последовательности. Распечатываемая таблица 
ниток включает название таблицы ниток, коды, 
марки и описание ниток. 

 
4  Используйте  при необходимости кнопки 

Preview (Просмостр): 
• Next Page: Просмотр следующей 

страницы. 
• Prev Page: Просмотр предыдущей 

страницы. 
• Two Page: Отображение в окне 

просмотра двух страниц. 
• Portrait/Landscape: Переключение 

между портретной и альбомной 
ориентацией страницы. 

• Zoom In/Out: Увеличить/Уменьшить 
изображение – используется для 
просмотра отдельных частей таблицы 
ниток. 

 
5  Щелкните по кнопке Print Now, чтобы 

приступить к процессу печати.  

Откроется диалоговое окно Print 
операционной системы MS Windows®,  
позволяющее выбрать принтер и выбрать 
желаемые настройки печати. 

 
6  Используйте черные прямоугольники в 

распечатываемом документе,  
чтобы отметить нитки, которые требуется 
купить. В таблице имеется  
также графа Memo для примечаний. 

 
7  Щелкните по кнопке Print. 
 

Вышивание проектов 
 
Используйте инструмент Write to 
Machine (панель General), чтобы 
передать проект в машину.  

 
 
 
Вы можете использовать функцию Write to 
Machine (Передать в машину) для 
непосредственной передачи проекта в готовую 
для работы вышивальную машину. Подробнее 
см. в разделе Передать в машину. 
 
 

 
 
Совет: Проверьте последовательность 
вышивания перед вышиванием проекта, так как 
вам нужно знать последовательность цветных 
фрагментов. Используйте функцию Print 
Preview (Предварительный просмотр), 
для просмотра информации о вышивании. 
Подробнее см. в разделе Предварительный 
просмотр проектов. 

Выбрать 
таблицу ниток 

для печати 

Щелкнуть для печати таблицы
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Как вышивать проект 
1 Откройте проект. 

Подробнее см. в разделе Открытие 
проектов из компьютера. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 Проверьте, подходит ли проект к пяльцам. 
Вышивайте проект в как можно меньших пяльцах. 
Подробнее см. в разделе Изменение пялец 
 
3 Щелкните по значку Write to Machine 
(Передать в машину). 
 
Если вы загружаете проект в первый раз после 
включения машины или модуля считывания карт, 
то появится диалоговое окно Bernina Device 
Selection (Выбор устройства Bernina). 
 

 
 
4  Если появится запрос, выберите 
вышивальную машину и COM-порт. 
 

5  Нажмите кнопку ОК. 
 

Если подсоединение выполнено правильно, 
откроется диалоговое окно Write to Embroidery 
System (Передать в вышивальную систему). 
На экране появится имя и пиктограмма вашего 
проекта. 

 

 
 

 
6 Нажмите кнопку Stitch out Selected Design 
(Вышивание выбранного проекта). 

Появится окно Writing file(s) to device 
(Передача файла(ов( в устройство), за 
которым последует сообщение о 
подтверждении. Проект будет передан в 
вышивальную машину, готовый к вышиванию. 
 

Примечание: Если вы отправили проекты 
непосредственно в машину, они могут быть 
потеряны после отключения машины. Помимо 
сохранения на жестком диске, на дискете или 
компакт-диске, вы можете также сохранять 
проекты в различных запоминающих 
устройствах. Сохраненные проекты могут быть 
извлечены для редактирования. См. также 
Запись проектов в машину. 
       
Считывание проектов из 
машины 
Вы можете загружать проекты в вышивальное 
программное обеспечение BERNINA из 
различных источников как в компьютер, так и в 
вышивальную машину. После открытия проекты 
могут быть проверены или выправлены перед 
сохранением на жестком диске или передачей в 
машину для вышивания или сохранения. При 
считывании проектов из машины имеются три 
возможности: 
¢ Embroidery machine (Вышивальная 
машина): Большинство машин позволяет 
сохранять проекты с возможностью 
последующего извлечения из памяти машины. 
Такое устройство подобно встроенной карте 
памяти. 
¢ Design card (Карта памяти): Проекты можно 
также сохранять на карте памяти вставленную в 
вышивальную машину. 

 
 

Выбор типа 
вышивальной  
машины

Нажмите для вышивания 
выбранного проекта. 
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¢ Устройство USB Memory Stick:  Проекты 
можно также загружать с устройства USB memory 
stick, вставленного в машину.  См. также Запись 
проектов в машину. 
 
 
 
 
 
 
 
 
Примечание: Устройство USB memory stick 
может быть вставлено непосредственно в ваш 
компьютер для загрузки в вышивальное 
программное обеспечение BERNINA. Подробнее 
см. в разделе Открытие проектов. 
 
Как считывать проекты из машины 
1  Если вы намерены считать проекты с карты 

или USB stick, вставьте запоминающее 
устройство в машину (или модуль  
считывания и записи карт памяти). Появится 
диалоговое окно  
Read from Embroidery System and Design 
Manager (Считывание  
с вышивальной системы и диспетчер 
проектов). 

Примечание: Подробнее о подсоединении см. в 
инструкции, прилагаемой к устройству 
считывания и записи вышивальных карт памяти. 

      
2  Выберите File > Card/Machine Read.   
 Если вы загружаете проект в первый раз 

после включения машины или модуля 
считывания карт, то появится диалоговое окно 
Bernina Device Selection (Выбор 
устройства Bernina). 

 
3  Выберите вышивальную машину или 
устройство считывания карт, а также COM-порт, 
если появится запрос.  
4  Щелкните по ОК. 
 Если подсоединение выполнено правильно, 

откроется диалоговое окно Write to 
Embroidery System (Передать в 
вышивальную систему).  
Отобразится имя и пиктограмма.  

Появится диалоговое окно Read from 
Embroidery System and Design Manager 
(Считывание с вышивальной системы и 
диспетчер проектов). 

 

              
 
 
5  Выберите требуемое запоминающее 

устройство, щелкнув по соответствующей 
кнопке – вышивальной машины, карте памяти 
или USB memory stick. 

 Как только вы выберите кнопку, отобразятся 
все папки и проекты, сохраняемые в 
соответствующем устройстве памяти. 

 

        
 
 
 
Совет: Щелкните правой кнопкой по значку 
проекта для вызова всплывающего меню, 
используемого для переименования, удаления 
или просмотра свойств проекта. 
 
6  Щелкните по закладке папки (если имеется 

больше одной закладки) и/или по папке, чтобы 
локализовать проект. 

 Совет: Используйте значки в правой части 
панели для создания новых папок или 
навигации по структуре папок. 

 
7  Выберите проект. 
 В панели Selected Design (Выбранный 

проект) отобразится изображение проекта. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Выбор 
типа 
устройства 

Выбор запо-
минающего 
устройства 

 
Выбор 
проекта 

 

Выбор 
 жесткого 

диска 
 

Щелкнуть для 
загрузки 

 
 

Выбор закладки
 

Щелчок правой 
кнопкой для 

доступа к 
выпадающему 

меню

Щелкнуть для  
открытия проекта  
в вышивальном  
ПО BERNINA 
 
 
Щелкнуть для  
доступа к свойствам  
проекта 
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8 Используйте кнопки панели, если 
потребуется:  

• отрыть проект для редактирования 
непосредственно в вышивальном 
программном обеспечении BERNINA 
ARTlink; 

• переименовать проект; 
• удалить проект; 
• получить доступ к свойствам проекта 

 

 
9  Выберите папку на жестком диске, в которой 
требуется сохранить проект.      
 

10   Щелкните по кнопке Download (Скачать), 
чтобы считать проект и сохранить его на жестком 
диске.  
 
Примечание: Вы можете записывать проекты  
в соответствующем формате с жесткого диска в  
запоминающее устройство, используя кнопку с 
зеленой стрелкой Upload (Загрузить). 

 
Запись проектов в память 
вышивальной машины    

 
Используйте инструмент Write to 
Machine (панель General), чтобы 
записать проект в память вышивальной 
машины, на карты памяти или на  

                 USB-Stick.  
 
Если вы намерены только вышить проект, когда 
машина подключена к компьютеру, то следует 
сохранить проект на жестком диске компьютера. 
Однако вы можете также использовать команду 

Write to Machine (Передать в машину), чтобы 
сохранить проект для последующего 
использования независимо от ПК. Проекты из 
любого запоминающего устройства – 
вышивальной машины, карты памяти или USB 
memory stick – могут быть затем вышиты в любое 
время. Таким образом, нет необходимости 
подсоединять компьютер к машине при 
вышивании проекта. Подробнее см. в 
документации к вашей вышивальной машине 
BERNINA. 
 
Как записывать проекты в память 
вышивальной машины 
1 Откройте свой проект в BERNINA ARTlink и 
выберите режим просмотра Design View. 
Подробнее см. в разделе Открытие проектов. 
 
 

Примечание: Машина (или внешнее устройство 
считывания/записи карт памяти) должна быть 
включена перед тем, как будет вставлена карта 
памяти, в противном случае проекты не 
откроются или не будут загружены в машину. 
 
2  Если вы намерены сохранить проект на карте 

памяти или в USB stick, вставьте 
запоминающее устройство в машину (или 
модуль считывания и записи карт памяти). 

 Подробнее о подсоединении см. в инструкции, 
прилагаемой к  
устройству считывания и записи 
вышивальных карт памяти. 

 
3  Щелкните по значку Write to Machine 
(Передать в машину). 
 
Если вы загружаете проект в первый раз после 
включения машины, то появится диалоговое окно 
Device Selection (Выбор устройства). 

 

 
4 Выберите тип вышивальной машины и при 
необходимости   последовательный порт. 

 
5    Нажмите кнопку ОК. 

Используйте эти кнопки для 
навигации и создания новой 

папки 

Используйте кнопку со 
стрелкой, чтобы передать 
выбранные проекты с 
жесткого диска в 
запоминающее устройство 

Выбор типа 
вышивальной 
машины 
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Если связь с последовательным портом 
установлена правильно, то появится 
диалоговое окно Write to Embroidery System 
(Передать в вышивальную систему)  и имя и 
картинка вашего проекта.  
 

 
 Запись в память машины     

Запись на карте     Запись  
на USB-Stick 

 
 
Выберите 
папку,  
в которой 
будет  
сохранен 
проект  
 
 
 

Проект, который будет   Кнопка 
записан в память машины       Download   

для записи 
  
6  Выберите требуемое запоминающее 

устройство, щелкнув по соответствующей 
кнопке – вышивальной машины, карте памяти 
или USB memory stick. 

 
Как только вы выберите кнопку, отобразятся все 
папки и проекты, сохраняемые в 
соответствующем устройстве памяти. 

 
7 Щелкните по закладке папки, в которой 

должен быть сохранен проект. 
 
Совет: Используйте кнопки в правой части 
панели для создания новых папок или навигации 
по структуре папок. 
fЩелкните правой кнопкой по значку проекта для 
вызова всплывающего меню, используемого для 
переименования, удаления или просмотра 
свойств проекта. 

 
Примечание: Убедитесь в том, что во время 
загрузки проекта в машину стержень 
игловодителя находится в верхнем положении. 
 
6 Щелкните по кнопке Download, чтобы 
загрузить проект.  

Сенсорный дисплей машины во время 
загрузки проекта остается пустым. Проект 
теперь сохранен в памяти машины. Вы 
можете вышить проект в любое время, не 
подсоединяя компьютер к вашей машине. 

Запись проектов 
непосредственно на USB-Stick 
 

 
Используйте инструмент Write to 
Machine (панель General), чтобы 
записать проект непосредственно на 
USB-Stick.  

 
Проекты можно сохранять на 
специализированных устройствах BERNINA USB 
memory stick или OESD USB memory stick, 
подключенных к ПК. Вы можете копировать 
проекты непосредственно с жесткого диска на 
USB memory stick через MS Windows® Explorer, но 
для этого нужно пользоваться программой 
BERNINA Embroidery Software. При сохранении 
проекта  BERNINA ARTlink автоматически 

конвертирует его в правильный формат 
для вышивки. 
 
Примечание: Другие типы устройств USB 
stick также могут быть использованы, но 
они автоматически не распознаются 
программным обеспечением. 
 
Как записать проект 
непосредственно на USB stick 
 

1  Откройте проект и выберите Design View. 
Подробнее см. в разделе Открытие проектов. 

 
 
 
 
 
 
 
 
 
 
 
2  Вставьте BERNINA или OESD USB memory 

stick непосредственно в USB-порт 
компьютера. 

3  Щелкните по значку Write to Machine 
(Передать в машину). 

 

Выбор 
закладки для 

папок 

Выбор папки 

Щелчок правой 
кнопкой для вызова 
всплывающего меню 

Создание 
новых папок 
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Если вы загружаете проект в первый раз после 
включения машины или модуля считывания карт, 
то появится диалоговое окно Bernina Device 
Selection (Выбор устройства Bernina). 

 
 
 
Совет: Если вы уже подключили вышивальную 
систему, щелкните по кнопке Connected Device 
(Подключенное устройство) в диалоговом окне 
Write to Embroidery System (Передать в 
вышивальную систему), чтобы получить доступ 
к диалоговому окну Bernina Device Selection 
(Выбор устройства Bernina). См. также Запись 
проектов в машину. 
 

 
4  Выберите опцию BERNINA USB Stick и 
щелкните по OK. 
Если вы вставили устройство USB memory stick, 
полученное не от BERNINA  
или OESD, откроется диалоговое окно Enter 
Drive Letter and Path  
(Ввод буквы привода и пути), предлагающее 
определить место устройства.  

 
 
5  Если необходимо, найдите место устройства 
в ПК. 

 
Если подсоединение выполнено правильно, 
откроется диалоговое окно Write to Embroidery 
System (Передать в вышивальную систему). 
На экране появится имя и изображение вашего 
проекта. Будут отображены также папки и 
проекты, подлежащие сохранению в устройстве. 
 

 
 
 
6  Выберите место устройства для сохранения. 
 
Совет: Используйте значки в правой части 
панели для создания новых папок или перехода 
по структуре папок. Щелкните правой кнопкой по 
файлам уже сохраненненного проекта для 
вызова всплывающего меню, используемого для 
переименования, удаления или просмотра 
свойств проекта. 
 
7  Щелкните по кнопке со стрелкой, чтобы 

записать проект на USB memory stick. 
 При сохранении проекта  BERNINA ARTlink 

автоматически конвертирует его в 
правильный формат для вышивки.  
См. соответствующую документацию по 
BERNINA ARTlink для более подробной 
информации о вышивании с USB memory 
stick. 

 

 

Выберите 
BERNINA USB 
Stick

Щелкните, чтобы перейти к 
диалоговому окну Bernina 
Device Selection 

Щелкните, чтобы 
выбрать путь к 
устройству USB

Выберите 
папку

Щелкните для 
загрузки выбранного 

проекта

Проект, 
подлежащий 
сохранению
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Приложение A  
 

ВERNINA ARTLINK –  
КЛАВИАТУРНЫЕ КОМАНДЫ 

------------------------------------------- 
 
Работа с проектами    Выбор объектов 
 
Чтобы … следует нажать  Чтобы … следует нажать 

открыть существующий 
проект  Ctrl + O   выделить все объекты Ctrl + A 

сохранить проект Ctrl + S  отменить выделение всех объектов Esc или X 

распечатать проект. Ctrl + P 
 перемещать выделенные объекты 

отдельными шагами 
клавиши со  
стрелками ↑ , ↓ , 
←  и → 

выйти из программы Alt + F4   удалить выделенный объект Delete 
 
Просмотр проектов 
 
Чтобы … следует 

нажать 
или 

уменьшить в 2 раза Shift + Z F10 
увеличить до размера 
выделенной зоны 

B F8 

установить масштаб 1:1  
(100 %) 

1  

показать проект целиком 0 (ноль) F2 
задать  коэффициент 
масштабирования 

F F3 

выровнять по центру текущий 
стежок 

C F6 

вернуться к предыдущему 
экрану просмотра 

V F5 

перерисовать экран R F4 
активировать замедленное 
перерисовавание 

Shift + R  

Показать точки прокола иглы (.)   (точка) 
Просмотр последовательности вышивания 
 

следует нажать Чтобы перейти ... 
на основной 
клавиатуре 

на цифровой 
панели  

к началу проекта  Home 7 
к концу проекта  End 1 
к следующему цвету  PageDown 9 
к предыдущему цвету  PageUp 3 
к следующему объекту  Ctrl+T  
на 1 стежок вперед †  → 6 
на 1 стежок назад †  ← 4 
на 10 стежков вперед †  ↓ 2 
на 10 стежков назад †  ↑ 8 
на 100 стежков вперед   + 
на 100 стежков назад   - 
* Клавиша Num Lock отключена  
† Функция инструмента Select Object отключена 
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